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Introduction About this Guide ii
Introduction

Welcome Welcome to Sterling Commerce’s Gentran:Server for UNIX® electronic data 
interchange (EDI) and electronic commerce (EC) software. 

Who should use
this guide

This guide is for the following audiences:

◗ Administrators responsible for installing and configuring EDI or EC application 
software

◗ Users of the Gentran:Server Workstation product

Use this table to determine which chapters are for you. 

Reference
See the Chapter Content topic for a description of each chapter. 

Note
This guide documents procedures for both the Application Integration Mapper and 
the Visual Mapper. Unless otherwise stated, the procedures for using these 
mappers are the same.

(Continued on next page)

If you are... Then refer to...

An administrator Chapter 1-2

Using Gentran:Server for the 
first time

Chapters 3-5

A user and you are upgrading 
from Gentran:Server 5.4

Chapters 3-5

A user and you are upgrading 
from Gentran:Server 5.3 or 
prior version

Chapters 3-6
Getting Started Guide – March 2011



About this Guide Introduction  iii
Required skills This guide assumes that you are familiar with basic Windows concepts and 
commands, including:

◗ How to navigate and operate within the Windows environment
◗ How to use DOS commands and the DOS window within the Windows 

desktop

Product
packaging

Your Gentran:Server Workstation package should include the following items:

◗ A CD containing the Gentran:Server Workstation software and the 
Communications Toolkit

◗ A CD containing the Gentran:Server EDI Standards
◗ A CD containing the Gentran:Server online documentation
◗ The Gentran:Server Workstation Getting Started Guide

Notes
If your company purchased the ODBC Database Drivers, your package should 
also contain:

◗ A CD containing the ODBC Database Drivers
◗ The Installation Card for ODBC Drivers
If your company is continuing to use the Visual Mapper (versions 5.3 and prior), 
then your package should also contain:

◗ A CD containing the Visual Mapper
◗ The Installation Card for Visual Mapper - Workstation

WARNING
If additional installation instructions came with your Gentran:Server 
for UNIX shipment, those instructions take precedence over the 
instructions listed here.
Getting Started Guide – March 2011



Supported Configurations About this Guide iv
Supported Configurations

Hardware
specifications

Each workstation computer needs the following resources for you to install and 
run Gentran:Server Workstation version 6.1.

◗ A CD-ROM drive
◗ A Pentium-class or equivalent processor
◗ A minimum processor speed of 166 MHz (333 MHz recommended)
◗ A color VGA or SVGA monitor
◗ Microsoft Windows 98®, Windows ME®, Windows NT® 4.0 SP6a, or Windows 

2000 (Server and Professional) SP1
◗ A minimum of 32 MB of memory (64 MB recommended)
◗ A minimum of 195 MB of free disk space for the Gentran:Server software. 

(Additional disk space is necessary for customer data, archive, EDI 
standards, etc.)

◗ A minimum of 300 MB of free disk space for the EDI Standards database to 
install the standards on your hard drive, or 50 MB of free disk space on your 
workstation if you install the standards on a network server

◗ Microsoft Internet Explorer 5.0 or higher

Note
Your Windows operating system may require updates to work correctly. Check the 
following Microsoft web site to determine and download the latest service packs 
for your operating system:

http://www.microsoft.com/windows/downloads/default.asp

(Continued on next page)
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About this Guide Supported Configurations  v
ODBC option -
translation

requirements

Gentran:Server’s ODBC translation option only supports the following databases 
and versions:

Operating 
Systems Database

Windows 98

Windows ME

Windows NT® 4.0 
plus SP6a

Windows 2000 
(Server and 
Professional) plus 
SP1

Informix 7.x, 9.x (via Informix Connect)

Informix Dynamic Server 9.x, Informix 2000

Oracle 7.1, 7.2, 7.3 (7.x functionality via SQL*Net 2.x)

Oracle 8.0.5+, 7.3, 8i (via NET 8, 8.04+)

Oracle 8.16

Note: Support for Oracle databases does not include 
support for the Oracle Exadata platform.

Sybase SQL Server 4.92

Sybase System 10, 11, Adaptive Server 11.x, 12.0

Sybase ASE (System 10, 11, Adaptive Server 11.x, 12.0)
Getting Started Guide – March 2011



Chapter Content About this Guide vi
Chapter Content

Description of
content

This table describes the content of the chapters within the Gentran:Server 
Workstation Getting Started Guide.

Chapter Title Description

About this Guide This preface describes the purpose and content 
of this guide. It describes the supported 
hardware and software configurations.

Chapter 1 - Installing 
Gentran:Server Workstation

Explains how to install Gentran:Server 
Workstation version 6.1 into a new directory.

Chapter 2 - Setting Up 
Communications

Explains how to set up communications using 
CLEO software. 

Chapter 3 - Introducing 
Gentran:Server

Describes the basic architecture of the 
Gentran:Server software.

Chapter 4 - Using 
Gentran:Server

Explains how to start and exit Gentran:Server, 
describes the user interface, and explains how 
to set default values for your system.

Chapter 5 - Working with 
Application Integration

Contains procedures for working with 
Application Integration Mapper files in 
Workstation. Includes instructions for checking 
out, saving, and checking in files.

Chapter 6 - Working with 
the Visual Mapper

Contains procedures for working with Visual 
Mapper files in Workstation. Includes 
instructions for checking out, saving, and 
checking in files.

Glossary Gentran:Server and industry-related terms.
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About this Guide Product Installation  vii
Product Installation

In this guide This guide explains how to install and configure:

◗ Gentran:Server Workstation version 6.1
◗ Online documentation for Gentran:Server
◗ The Gentran:Server Standards
◗ The Communications Toolkit

Note
These instructions apply only to new installations of Gentran:Server Workstation.

Installation
options

You can install each option separately after installing the core Gentran:Server 
software. This table lists the CD containing each option and the instructions for 
installing the option.

To install the… Use…

XML Translation 
Extension

the core installation CD.

Note
This option is installed during the core product installation. 
The serial number you enter validates your purchase of 
the XML Translation Extension.

HIPPA features the core installation CD.

Note
The installation process asks if you want to install optional 
HIPAA features for Gentran:Server Workstation 6.1.

ODBC Database 
Drivers

the Workstation ODBC Drivers installation CD.

Note
You need to supply a serial number to install the ODBC 
Database Drivers.

Reference
See the separate install card titled “ODBC Drivers - 
Workstation Installation Instructions.”

(Continued on next page)
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Product Installation About this Guide viii
Visual Mapper 
(earlier version of 
mapper available 
to customers with 
versions of 
Gentran:Server 
5.3 or earlier)

the Workstation Visual Mapper installation CD.

Note
You need to supply a serial number to install the Visual 
Mapper.

Reference
See the separate install card titled “Visual Mapper - 
Workstation Installation Instructions.”

Extensions the documentation shipped with other options or add-on 
software for installation instructions.

 (Contd)
To install the… Use…
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About this Guide Related Publications  ix
Related Publications

Gentran:Server
documentation

This table describes additional documentation for the Gentran:Server software.

Document Description

Upgrade and Data 
Conversion Guide

Instructions for upgrading from previous versions of 
Gentran:Server Workstation and Gentran:Server for 
UNIX. Also includes instructions for converting the files 
that are part of the upgrade.

Application 
Integration User’s 
Guide

Instructions for performing mapping and translation 
tasks using the Gentran:Server Application Integration 
Mapper. 

Mapping and 
Translation Guide

Instructions for performing mapping and translation 
tasks using the Gentran:Server Visual Mapper.

Note
This guide is provided only if you maintain maps 
created with Gentran:Server version 5.3 or prior.

NCPCP User’s Guide Instructions for mapping and translating NCPDP files 
with the Application Integration system.

XML User’s Guide Instructions for mapping and translating XML files with 
the Application Integration system.

Note
This guide is provided only if your organization has the 
Gentran:Server XML translation option.

ODBC User’s Guide Instructions for mapping and translating ODBC files 
with the Application Integration system.

Note
This guide is provided only if your organization has the 
Gentran:Server ODBC translation option.

GENCOD User’s 
Guide

Instructions for mapping and translating GENCOD files 
with the Application Integration system and the Visual 
Mapper.

VDA User’s Guide Instructions for mapping and translating VDA files with 
the Application Integration system and the Visual 
Mapper.

(Continued on next page)
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Related Publications About this Guide x
Technical Reference 
Guide

Describes processes, lists command-line commands in 
alphabetical order, and describes file record layouts 
and data type formats.

Maintenance and 
Troubleshooting 
Guide

Instructions for maintaining your Gentran:Server 
installation. Also provides troubleshooting information 
to help determine the cause and solution of problems 
that may occur.

Online Help Context-sensitive help screens describing the 
Gentran:Server dialog boxes for the mapping and 
translation features. Also includes procedures for using 
the mapping and translation and the data flow 
administration software.
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Overview 0

Introduction

Chapter contents This chapter contains instructions for installing Gentran:Server® Workstation® 
version 6.1 into a new directory structure.

Key terms This table describes key terms used in this chapter.

Term Description

default A value that is automatically assigned if the user enters 
no value.

Windows computer A PC that uses the Windows operating system. For 
Gentran:Server Workstation, the operating system can 
be:

◗ Microsoft Windows 98®

◗ Windows ME®

◗ Windows NT® 4.0 SP6a
◗ Windows 2000 (Server and Professional) SP1.
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Stages of Installation

Stage Table This table describes the stages of the installation process for Gentran:Server 
Workstation. Detailed instructions for completing each stage are contained in the 
sections that follow.

XML installation The XML translation option is installed on your computer automatically if your 
company purchased the option.

Stage Description

1 Installation of Gentran:Server Workstation into the default 
directories, or into a new directory created and named by 
you, and installation of the Communications Toolkit

2 Installation of Microsoft Data Access Components

3 Installation of Gentran EDI Standards

4 Installation of the Gentran:Server online documentation

5 Installation of Acrobat Reader version 4.0 or higher with 
search function

6 Installation of optional components, if applicable, including 
ODBC Database Drivers and Visual Mapper

7 Conversion of existing data, if upgrading from a previous 
version

Reference
See the Gentran:Server for UNIX and Workstation 
Upgrade and Data Conversion Guide for more 
information.
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Procedures 0

How to Install Gentran:Server Workstation

Introduction This topic explains how to install Gentran:Server Workstation software onto a 
Windows computer from the CD.

Procedure Use the following procedure to install the Gentran:Server Workstation.

Step Action

1 Close all programs running on your computer.

2 Insert the installation CD into the CD-ROM drive of your PC. 

3 Did the installation program start automatically and display the 
Welcome dialog box?

◗ If YES, GO TO Step 5.
◗ If NO, continue to next step.

4 Select Run from the Start menu in the Run dialog box, type the 
following command where <drive> represents the letter 
assigned to your CD-ROM drive, then click OK.

Example
<drive>:\setup

System Response
Setup displays the Welcome dialog box. 

5 Click Next to continue.

System Response
Setup displays the Gentran:Server 6.1 License 
agreement dialog box.

(Continued on next page)
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6 Click Yes to accept the license agreement and continue 
installation.

System Response
Setup displays the User Information and Registration 
dialog box.

7 Enter your name, company, and the serial number printed on 
the packing list. Click Next.

Note
You must complete all three fields to continue with 
installation of Gentran:Server Workstation.

System Response
Setup displays the Choose Destination Location dialog 
box.

8 Do you want to change the directory where Gentran:Server is 
installed? 

◗ If YES, continue with the next step.
◗ If NO, then GO TO Step 10.

WARNING
If you have an earlier version of Gentran:Server 
installed, be sure to use a different root directory for 
your Gentran:Server 6.1 software. 

(Continued on next page)
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9 Click Browse to go to the desired location and click OK; 
continue with the next step. 

Comments
You can type into the Browse dialog a path that Setup will 
create during installation. If the pathname contains a 
folder that does not exist, Gentran:Server displays the 
prompt: Do you want to the folder to be created?”

Be sure that the path you specify contains no spaces, 
and no punctuation other than a backslash (\) between 
directories.

10 Click Next to accept the destination.

System Response
Setup displays the HIPAA dialog box.

11 Do you want to install HIPAA features?

◗ If YES, click Yes.
◗ If NO, click No.

If you are not sure, we recommend that you choose No.

Note
If you choose Yes, each time it starts, Gentran:Server 
Workstation verifies that the computer’s password 
screen-saver feature is enabled.

System Response
Setup displays the Setup Type dialog box.

12 Do you want to select which components of the product to 
install?

◗ If YES, select Custom Installation and click Next. GO TO 
Step 15.

Note
Before you select the components you want to install, 
contact Customer Support for assistance.

◗ If NO, select Full Installation. Click Next and then 
continue with the next step.

(Continued on next page)
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13 Does a previous version of Gentran:Server still exist on your 
machine? 

◗ If YES, continue with the next step.
◗ If NO, GO TO Step 17.

14 Do you want to overwrite the previous installation?

◗ If YES, click YES and GO TO Step 17.
◗ If NO, click NO. Browse to a new destination and then click 

Next.

Caution
You should install Gentran:Server 6.1 into a new folder 
(directory) to prevent overwriting existing information.

15 Select the components you want to install from the list in the 
Select Components dialog. (Select to include a component; 
clear to omit it.)

Notes
The XML Component Files option only appears if the 
serial number you entered on the User Information and 
Registration screen validates your purchase of the XML 
Translation extension.

Click the Disk Space button to check for available disk 
space on other drives.

16 Click Next. 
(Continued on next page)
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17 Do you want to change the Program Folder to which Setup will 
add program icons?

◗ If NO, click Next.
◗ If YES, type a new folder name, or select one from the 

existing Folders list, and click Next.

System Response
Setup displays the Sub-Directory Name dialog box.

18 Do you want to accept the default program sub-directory 
names?

◗ If YES, click Yes and GO TO Step 20.
◗ If NO, click No and continue with the next step.

19 Type the path names of the sub-directories to which you are 
installing the Gentran:Server files. When you are finished, click 
Next to save your changes.

Comment
You can type paths that Setup will create during 
installation. Be sure that the paths you specify contain no 
spaces, and no punctuation other than a backslash (\) 
between directories.

System Response
Setup displays the Check Setup Information dialog box.

(Continued on next page)
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20 Are the displayed current settings correct?

◗ If YES, click Next to continue.
◗ If NO, click Back until you find the dialog you must change. 

Make your changes, then click Next until you return to the 
Check Setup Information dialog box. Click Next to 
continue.

System Response
Setup displays progress information as it installs the 
software. 

WARNING
The Setup script displays warning messages if it 
cannot copy one or more Gentran:Server files to the 
destination. Write down each message before you 
click OK to dismiss it.

21 Did the Setup program display any warning messages during 
the installation process?

◗ If YES, click Exit and continue with the next step.
◗ If NO, Setup displays the View Readme File dialog box. 

GO TO Step 23.

22 Are any programs running on the client other than the 
Gentran:Server Setup program?

◗ If YES, then close those programs and return to Step 3. 
◗ If NO, call Customer Support with a list of the warning 

messages.
(Continued on next page)

 (Contd)
Step Action
Getting Started Guide - March 2011



How to Install Gentran:Server Workstation Installing Gentran:Server1 - 10
23 Do you want to want to view the README file at this time?

◗ If YES, click Yes and close the window when finished.
◗ If NO, click No.

System Response
Setup displays the Setup Complete dialog box.

24 Do you want to install the Microsoft Data Access Components 
(MDAC)?

◗ If YES, GO TO topic How to Install MDAC 2.6 Components 
in this chapter.

◗ If NO (you already have MDAC), clear the checkbox and 
continue to the next step.

Note
You must have MDAC to use the Gentran EDI Standards 
database. The minimum version required is 2.1sp1a. This 
MDAC installation process installs version 2.6.

25 Click Finish.

26 Do you want to let Setup restart the computer now?

◗ If YES, remove any disks from the disk drive and click Yes.
◗ If NO, click No.

27 Click Finish to complete setup.

System Response
Setup displays the Gentran:Server 6.1 dialog box

 (Contd)
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How to Install MDAC 2.6 Components

Introduction To read the EDI standards provided with Gentran:Server for UNIX, you must have 
Microsoft Data Access Components (MDAC) 2.1sp1a or higher installed on each 
PC or client. MDAC include ActiveX® Data Objects (ADO), OLE DB, and Open 
Database Connectivity (ODBC). Data-driven client/server applications use these 
ODBC drivers and other components to integrate information from a variety of 
sources. 

If you do not already have MDAC on the PC, you must install it before you install 
the EDI standards. This topic explains how to install MDAC.

Installing MDAC Use this procedure to install MDAC 2.6 on a PC. 

Step Action

1 Use this table to determine your first action.

IF you are … THEN…

Continuing from the PC 
setup program

Leave the I would like to install 
Microsoft MDAC 2.6 check box 
selected on the Setup Complete 
dialog box. Click Finish and GO 
TO Step 5.

Installing MDAC after 
exiting the PC setup 
program

Continue with Step 2.

2 Insert the installation CD into the CD-ROM drive of the PC 
computer. 

3 Select Run from the Windows Start menu.

System Response
Windows displays the Run dialog box.

(Continued on next page)
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4 Type the following command in the Run dialog box and click 
OK.

<drive>:\mdac_typ.exe

where <drive> is your CD-ROM drive.

System Response
Your system loads the Microsoft Data Access 
Components 2.6 Setup program and displays the 
Microsoft Data Access Components 2.6 Setup dialog box. 

5 Select the checkbox on the End User License Agreement of the 
Microsoft Data Access Components 2.6 Setup dialog box to 
accept the terms of the licensing agreement; then click Next.

System Response
Setup displays the Microsoft Data Access Components 
2.6 Setup dialog box.

6 Click Next.

7 Click Finish.

8 Click Close.

System Response
Setup displays the Gentran:Server Setup complete dialog 
box, which asks whether you want to reboot the PC now 
or later.

9 Do you want to restart the PC now?

◗ If YES, click Yes. Remove any disks from the PC disk 
drives.

◗ If NO, click No. 

10 Click Finish to complete setup.

 (Contd)
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How to Install Gentran Standards

System
requirements

The amount of hard disk space required to use the Gentran EDI Standards 
database depends on the following:

◗ New install (run from EDI Standards CD)
Approximately 10 MB of hard disk space to install the EDI Standards 
database to run from the CD.

◗ New install (install on hard drive)
Approximately 300 MB of hard disk space to install the EDI Standards 
database to run from your hard drive.

Before you begin You must install Microsoft Data Access Components (MDAC) 2.1sp1a or higher 
before you install Gentran EDI Standards. 

Caution
Install your Gentran product before you install the EDI Standards database.

Note
If you have already set up this machine to run EDI standards from the CD-
ROM drive, you only have to exchange the old standards CD for the most 
current Standards CD. You do not have to complete the installation 
procedure below.

Updated
versions
included

Please refer to the readme.txt file provided on the Gentran:Server Standards CD 
for the most current information about the standards. 

For fast access, install the Gentran EDI Standards database on your hard drive. 
This requires approximately 10 MB of free space for the temporary installation 
files and 300 MB for the EDI Standards database. You can also access the 
Gentran Standards database directly from the CD-ROM.

The Gentran EDI Standards database is updated periodically, produced on CD-
ROM separate from products, and available at your request (usually on a 
quarterly basis).

Additional
standards

included

The Standard CD also contains folders for NCPDP and VDA standard templates. 
See the Gentran:Server for UNIX and Workstation HIPAA Compliance and 
NCPDP User’s Guide and the Gentran:Server for UNIX and Workstation VDA 
User’s Guide for instructions on how to copy the templates.

(Continued on next page)
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Installing the
Standards
Database

Complete the following steps to install the EDI Standards database:

Step Action

1 Close all programs on your computer.

2 Insert the Gentran Standards CD into your CD-ROM drive.

3 Select Run from the Start menu.

4 Type <drive>:\I386\setup.exe

Where: <drive> is your CD-ROM drive (for example, D:\ or E:\)

System Response
Setup prepares the wizard that guides you through the install 
program. This may take several seconds. When the wizard is 
ready, the system displays the Welcome dialog box.

(Continued on next page)
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5 Click Next> to continue the Setup program.

System Response
Setup displays the Install Standards dialog box.

(Continued on next page)
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6 Use the following table to determine your next action.

IF you 
select… THEN… AND…

Install to run 
from the CD-
ROM

Click Next> to install 
the EDI Standards 
database and the 
ODBC components

System 
Response
Setup 
displays the 
Select ODBC 
Data Source 
dialog box.

Proceed with Step 7.

Install to run 
without CD-
ROM

Click Next> to install 
the EDI Standards 
database and 
ODBC components.

System 
Response
The system 
displays the 
Standards 
Destination 
dialog box.

Type the destination or click 
Browse and select where 
you want the EDI Standards 
database to be stored. 
Proceed with Step 7.

System 
Response
The system displays 
the Select ODBC 
Data Source dialog 
box.

Note
At least 300 MB must 
be available. If there 
is insufficient space 
available on the drive 
you specified, you will 
be prompted to select 
another location or 
increase the amount 
of space available in 
the target directory.

Map an 
ODBC Data 
Source to an 
existing 
Database

Do not select this 
option.

(Continued on next page)
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7 Use the table to determine your next step.

IF you… THEN…

Accept the default 
Gentran Standards

Click Next

Specify a new data 
source name

Type the name in the field and the Click 
Next.

System Response
The system displays the prompt: Setup is ready to install 
Gentran Standards. Would you like to proceed?

8 Click Yes to install Gentran Standards.

Note
If you receive messages that a .DLL is currently in use, click 
Ignore to continue the installation. You receive these 
messages when a service (like the SQL Executive service) is 
running in the background. The system will still install the EDI 
Standards database correctly.

System Response
Setup displays a message indicating that the EDI Standards 
database installation is complete.

9 Click OK.

 (Contd)
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How to Install Optional Components

Introduction If you have the following optional components for Gentran:Server Workstation 6.1, 
install them now.

◗ ODBC Database Drivers
◗ Visual Mapper

ODBC Database
Drivers

Use the Workstation ODBC Database Drivers installation CD and see the 
separate card titled “ODBC Drivers - Workstation Installation Instructions” for 
detailed instructions.

Visual Mapper Use the Workstation Visual Mapper installation CD and see the separate card 
titled “Visual Mapper - Workstation Installation Instructions” for detailed 
instructions.
Getting Started Guide - March 2011



Installing Gentran:Server How to Convert Existing Data 1 - 19
How to Convert Existing Data

Introduction If you are upgrading from Gentran:Mentor or from an earlier version of 
Gentran:Server, you need to convert your existing data. 

Reference Refer to the Gentran:Server for UNIX and Workstation Upgrade and Data 
Conversion Guide for detailed instructions.
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Overview 0

Introduction

The
Communications

Toolkit

The Communications Toolkit enables Gentran:Server® to use Cleo A+® or 
Cleo 3780Plus® communication software to access a Value-Added Network 
(VAN). 

Among other services, VANs provide store-and-forward messaging in a dial-on-
demand environment. This means that the VAN stores files in a mailbox until the 
recipient to whom they are addressed dials into the VAN and picks them up. 

When to use the
Communications

Toolkit

Use the Communications Toolkit if you connect to the Commerce Net®, 
Advantis®, or GEIS® networks, and you use or plan to use either Cleo A+ or Cleo 
3780Plus.

What do I need
to buy?

The Communications Toolkit is included with Gentran:Server Workstation® and all 
product levels of Gentran:Server for UNIX®. 

However, Cleo A+ and Cleo 3780Plus are not part of the Gentran:Server product; 
you must purchase Interface Systems’ Cleo A+ or Cleo 3780Plus communication 
software. 

How to activate
the

Communications
Toolkit

To activate the toolkit functions, you need to configure the Communications Toolkit 
and then install the Cleo software.

Communications Toolkits files are included in the Gentran:Server for UNIX host 
CD and are installed automatically with the Gentran:Server host software.

In this chapter This chapter provides instructions for setting up the toolkit.
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What Is the Communications Toolkit?

Command
scripts

Sterling Commerce provides command scripts for the third-party communication 
packages, Cleo 3780Plus and Cleo A+. The scripts control the processes of:

◗ Dialing the VAN
◗ Logging in
◗ Transmitting waiting files
◗ Receiving any files waiting on the VAN
◗ Logging off 
◗ Exiting

Supported VANs This table describes the VANs and protocols supported by the Communications 
Toolkit.

Toolkit parts There are two primary parts to the Communications Toolkit provided with 
Gentran:Server:

◗ Cleo A+ scripts and configuration files
◗ Cleo 3780Plus scripts and configuration files

(Continued on next page)

VAN Supported Protocols

Sterling Information Broker

(Sterling Commerce)

Asynchronous-ASCII

Bisynchronous

Advantis 

(IBM)

Asynchronous-Xmodem

Bisynchronous

GEIS 

(General Electric Information System)

Asynchronous-Xmodem

Bisynchronous
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Cleo software Cleo A+

Interface Systems’ Cleo A+ is an asynchronous communications package that 
uses sophisticated scripting to handle various types of communications. It 
supports several file transfer methods, including ASCII, Xmodem, Ymodem, 
Zmodem, Kermit, and ANSI CLEAR. It can also perform as an FTP tool, using 
SLIP, PPP, Telnet, or local modes.

Cleo 3780Plus

Interface Systems’ Cleo 3780Plus is a bisynchronous communications package 
that uses scripting to handle various types of communications. It supports 2780/
3780 bisync protocols by using a piece of hardware to convert ASCII data to 
EBCDIC data for transmission and EBCIDIC data to ASCII data upon receipt of 
the EBCDIC data.

WARNING
The scripts in the Communications Toolkit expect to find the Cleo 
software in a specific directory relative to the Gentran:Server 
directories. To prevent complications, install the Cleo software after 
you install and set up Gentran:Server and the Communications 
Toolkit.
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COMM Subdirectory Structure

Diagram The following diagram illustrates the directory structure required by the 
Communications Toolkit. Installation of Gentran:Server for UNIX automatically 
installs the Communications Toolkit files for you.

Location of
communication

scripts and
configuration

files

The Cleo communications script and configuration files reside in subdirectories of 
the COMM CleoA or CleoB subdirectory of the Server directory.  

(Continued on next page)

G ENTRAN:Server
Installation directory CO M M

CleoA
(A+)

CleoB
(3780P lus)

adv

cnet

geis

adv

cnet

geis

Directory Contents

Server/COMM/CleoA 

                 (A+)

Holds Cleo A+ asynchronous package

Server/COMM/CleoB

            (3780Plus)

Holds Cleo 3780Plus bisynchronous package
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VAN
subdirectories

Under the CleoA and CleoB subdirectories, each VAN has its own subdirectory:

◗ cnet for Sterling Information Broker
◗ adv for Advantis
◗ geis for GEIS.

Subdirectory
contents

The adv, cnet, and geis subdirectories contain files that enable the 
communications application to communicate with the corresponding VAN.

You should use the subdirectory appropriate to your network to hold the outbound 
file <van>s that you are transmitting to the VAN. 

Note
You should place files you are sending in the communications subdirectory before 
a session. For example, to send a file to Advantis via an asynchronous 
communication session, place the file in Server/COMM/CleoA/adv/advs.

During a session, the system places the inbound file <van>r.000 in the 
communication subdirectory. This file contains any files received during a 
communications session. 

Important files This table lists the important files that the Communications Toolkit uses or creates. 

Filename Description

<van>.cfg A configuration file specific to the VAN indicated in the 
file name.

edilog.fil A log file produced by each bisynchronous Advantis 
session.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

advmsg.fil A file containing messages produced by each 
bisynchronous Advantis session.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

(Continued on next page)
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<van>*.job Cleo job file for connecting to the supported networks. 
The individual files connect as follows:

◗ cnetsr.job - Sterling Information Broker via the 
CompuServe network local access nodes.

◗ advsr.job - IBM Advantis network
◗ geissr.job - GEIS network

<van>.log A log file specific to the last connection made to the 
indicated VAN.

<van>.mon A monitor file specific to the last connection made to 
the indicated VAN.

<van>.ovr A data translation file that provide protocol transfer 
information that Cleo requires.

cnet.rpts A file containing Sterling Information Broker reports. 

<van>s The user data file to be sent to the network. Must be 
placed in the directory for the specific VAN before 
connecting to the VAN. 

WARNING
You must move or delete this file after 
completing the session successfully. 

Gentran:Server will send a duplicate 
transmission unless this file is overwritten or 
deleted before the next session.

Gentran:Server may overwrite the file if you 
do not move it before the next session. The 
file will then be unavailable to retransmit data.

(Continued on next page)
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<van>r.nnn The user data file that Gentran:Server receives from 
the VAN. The first file received has an extension of 
.000. If the file is moved from the VAN directory before 
another file arrives, the next file received also has an 
extension of .000.

WARNING
The file extension is incremented by one with 
the receipt of each new file unless the prior 
version is moved or deleted before the 
session. If your site uses automated file 
processing, it may not recognize the 
incremented file. 

geisrpt.* A session log report generated by GEIS under 
3780Plus or AllSync.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

 (Contd)
Filename Description
Getting Started Guide - March 2011



Setting Up Communications The Communications Toolkit Setup Process 2 - 9
The Communications Toolkit Setup Process

Process flow This diagram shows the flow of the setup process required to prepare the 
Communications Toolkit to work with Gentran:Server.

Set Up 
Communications

Toolkit

Install Cleo 
Communications

Software

Install
Gentran:Server
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Procedures 0

How to Set Up Asynchronous Communications

Introduction This topic contains the procedures for setting up asynchronous communications 
using VAN scripts that are located in the COMM directory structure. Follow the 
instructions for the VAN to which you are connecting.

Microcom
Network

Protocol (MNP)

The Microcom Network Protocol (MNP) enables error correction during 
transmissions. It is particularly important when connecting to Sterling Information 
Broker. 

Modifying the
VAN

configuration file

Your Cleo A+ VAN configuration file (cnet.cfg, adv.cfg, or geis.cfg) contains all or 
most of the required network configurations. However, you may have hardware 
issues that require you to modify the file.

This table lists the environment parameters you may need to modify. The 
Parameter column lists the name of the parameter and the related file.

Parameter Description

Modem 
Initialization 

(modeminit.cfg)

This parameter normally contains the async factory 
default setting for your modem. To use another setting, 
check the AT commands in your modem user’s guide. 
Usually, the setting & F0 sets up most asynchronous 
modems in standard asynchronous mode. 

Port

(device.cfg)

This is the port to which the modem is installed. 

◗ If you use DOS or Windows, you may use COM2 or 
a similar setting.

◗ If you use UNIX, you may use /dev/ttyp3 or a similar 
setting.

Port Speed

(speed.cfg)

This parameter identifies to Cleo the baud rate of the port 
so that Cleo knows how fast to write to the port. This is 
NOT the dial-up connection speed or the modem’s baud 
rate.

(Continued on next page)
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Terminal Type

(terminal.cfg)

The terminal type is usually VT100 or VT220, depending 
on the terminal type to be emulated. Refer to the Cleo 
documentation for more information.

Dial Initialization This is the most important configuration parameter. It is 
used to set the unique configuration that a particular VAN 
expects. Use the following table to guide you in setting 
this parameter.

VAN Dial-Initialization Settings

Sterling
Information
Broker

◗ MNP error correction protocol
◗ Software Flow Control (also known 

as XON/XOFF Flow Control)

Advantis ◗ MNP error correction protocol
◗ Hardware Flow Control (RTS/CTS)
◗ FTP: Xmodem (in addition to the 

MNP protocol)

GEIS ◗ Either Hardware Flow Control 
(RTS/CTS) or Software Flow 
Control

CAUTION
If you use Software Flow Control, 
make sure the Dial Init and 
FLOWCONTROL setting in the 
configuration file are compatible.
◗ FTP: Xmodem

 (Contd)
Parameter Description
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How to Set Up Bisynchronous Communications

Introduction This topic contains the procedure for setting up bisynchronous communications 
using VAN scripts that are located in the COMM directory structure. Follow the 
instructions for the VAN to which you are connecting.

Editing the
configuration file

Your Cleo 3780Plus VAN configuration file (cnet.cfg, adv.cfg, or geis.cfg) contains 
all or most of the required network configurations. However, you may have 
hardware issues that require you to modify the file.

The parameter settings that sometimes need to be increased are:

◗ Wait Limit
◗ Retransmission Limit

Important
The configuration file does not contain any labels. Consult the Cleo 
documentation to determine which lines to edit within the file.

Use this procedure to edit the configuration file for Sterling Information Broker, 
Advantis, and GEIS.

(Continued on next page)

Step Action

1 Open the VAN Configuration File in a text editor.

2 Set the Wait Limit as needed.

3 Set the Retransmission limit as needed.

4 Initiate a Cleo session so you can test communications to the 
VAN. 

5 Check whether a completion status of ‘0’ was returned.

◗ If the status was 0, you are finished editing the 
configuration file.

◗ If a non-zero was returned, use the <van>.log and 
<van>.mon files to troubleshoot.

Reference
See the topic Cleo 3780Plus Troubleshooting for more 
information.
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Editing the job
file

Use this procedure to edit the job file for cnet bisync communications.

Step Action

1 Open the job file in a text editor.

2 Set the dialing command.

Example
AUTODIAL n-nnn-nnn-nnnn T60 R3

Where 

n-nnn-nnn-nnnn is the connection telephone number

T60 is the time in seconds to wait for a connection to complete

R3 is the number of times to retry a connection attempt.

Comment
We recommend that you use the default time and retry 
settings.

3 Set mailbox ID and password. You must set it in three separate 
places:

KEY $$REQ ID=xxxxxR BID=’nnnnnnn’ -x

KEY $$REQ ID=xxxxxD BID=’nnnnnnn’ -x

KEY $$ADD ID=xxxxxD BID=’nnnnnnn’ -x

Where 

xxxxx is the five character network mailbox ID

nnnnnnn is the seven digit password.

Warning
These are the only changes to the job file approved 
by Sterling Commerce. Any other changes will NOT 
be supported by Sterling Commerce Support 
personnel.
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How to Start Up Cleo A+

Description Interface Systems’ Cleo A+ is an asynchronous communications package that 
uses sophisticated scripting to handle various types of communications. It 
supports several file transfer methods, including raw ASCII, Xmodem, Ymodem, 
Zmodem, Kermit, and ANSI CLEAR. It can also perform as an FTP tool, using 
SLIP, PPP, Telnet, or local modes.

Cleo A+ start-up
command

The Cleo A+ start-up command consists of the command to execute the 
application A+ and several parameters. The two most important parameters are 
the job file and tokens, which are explained below.

The rest of the information that you can place in the start-up command is identified 
within the job file. A log file is generated automatically. 

.job file This parameter identifies the job file to use for the session. The job file determines 
how Cleo manages a communication session. There is a separate job file for each 
VAN which ends with the extension .job. For example, the Advantis job file is 
advsr.job. 

This table lists the job file that corresponds to each supported VAN.

(Continued on next page)

VAN Async (COMM/CleoA/.) Job File

Sterling Information Broker via CompuServe .cnetsr.job

Advantis Expedite/Async .advsr.job

GEIS EDI*Express .geissr.job
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Tokens A token is a piece of information that is passed to a job, such as the VAN 
telephone number or your VAN ID. The token parameter identifies the tokens to 
be passed to the job as it is running. 

This table lists the available A+ tokens for each VAN.

(Continued on next page)

VAN
Token 

Number Description

Advantis 1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 IBM Network Account ID.

3 IBM Network User ID.

4 IBM Network Password.

5 Information Exchange Network Account ID.

6 Information Exchange Network User ID.

7 Information Exchange Network Password.

Sterling 
Information 
Broker

1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 Mailbox ID. (Sxxxx)

3 Mailbox password. (nnnnnnn)

4 Mailbox Application ID obtained from network 
support. (EDIx)

5 Report slot ID. (xxx)

6 Data slot ID. (xxx)

7 Node access host. (compu)

GEIS 1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 GEIS Network User Number.

3 GEIS Network User Password.

4 Last three digits of the GEIS User Number.
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Example start-up
command

A+ jobfile=./cnet/cnetsr.job “tokens=18005551212 SX999 1234567 EDIx R D mci”
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How to Start Up Cleo 3780Plus 

Description Interface Systems’ Cleo 3780Plus is a bisynchronous communications package 
that uses scripting to handle various types of communications. It supports 2780/
3780 bisync protocols by using a piece of hardware to convert ASCII data to 
EBCDIC data for transmission and EBCDIC data to ASCII data upon reception of 
the EBCDIC data.

Cleo 3780Plus
start-up

command

The Cleo 3780Plus start-up command consists of the Cleo command 3780Plus’ 
along with several other parameters. These are required parameters:

You can use the following optional parameters in the start-up command.

Note
The log is not required. However, Gentran:Server support personnel must have 
the log to assist you in troubleshooting any communication difficulties you may 
encounter. 

(Continued on next page)

Parameter Description

-d Identifies the device or communications port to use this 
session.

-j Identifies the .job file to run.

VAN Bisync (COMM/CleoB/..) Job File

Sterling Information Broker .cnetsr.job

Advantis Expedite/Direct .advsr.job

GEIS EDI*Express .geissr.job

-k Used to pass the tokens to the .job file as it is running.

Parameter Description

-c Identifies the configuration file to use. The .job file includes this 
information. 

-LO Directs Cleo to generate a new log for the session if one does 
not exist in the COMM directory or overwrite an existing one. 
This command is recommended. 
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GEIS and
Advantis tokens

This table lists the available 3780Plus or AllSync tokens for GEIS and Advantis.

Note
To control startup of bisynchronous communications for Sterling Information 
Broker, you need to edit the job file instead of using tokens.

Reference
See the How to Set Up Bisynchronous Communications topic in this chapter.

Example start-up
command

3780Plus -d /dev/tty03 -j ./geis/geissr.job -k 18005551212 GEISID GEISPSWDnnn -LO

VAN
Token 

Number Description

Advantis 1 Connection telephone number. 

2 IBM Network Account ID.

3 IBM Network User ID.

4 IBM Network Password.

5 Information Exchange Network Account ID. 

6 Information Exchange Network User ID.

7 Information Exchange Network Password.

GEIS 1 Connection telephone number.

2 GEIS Network User Number.

3 GEIS Network User Password.

4 Last three digits of the GEIS User Number.
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Start-Up Procedure Examples

Introduction Communications is not a Gentran:Server application and the procedures to start 
communications can vary from environment to environment. Once 
communications are set up, you use the same commands to start it regardless of 
the platform.

Initiating
communications

through
automated

procedures

The communications toolkit has certain expectations regarding file placement. 
You can automate processes to move the file to and from the VAN directories. You 
can also automate the start-up process using .bat files created in DOS or 
Windows, or shell scripts created in UNIX or open systems. 

Examples The following examples show what you can implement into an automated 
communications procedure.

DOS or Windows Users
.BAT File Example

copy C:\Server\ediout?.fil C:\Server\comm\cleoa\cnet\cnets

del C:\Server\ediout?.fil

cd \Server\comm\cleoa

aplus jobfile=.\cnet\cnetsr.job “tokens=5551212 SX999 1234567 EDIx R D mci”

copy C:Server\comm\cleoa\cnet\cnetr C:\Server\comm\cleoa\ediin?.fil

del C:\Server\comm\cleoa\cnet\cnetr

UNIX Systems Users
Shell Example

cp/Server/ediout?.fil /Server/comm/cleoa/cnet/cnets

rm/Server/ediout?.fil

cd/Server/comm/cleoa

A+ jobfile=./cnet/cnetsr.job “tokens=5551212 SX999 1234567 EDIx R D mci”

(Continued on next page)
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***error recovery procedures ie; if$? =gt 0 ...****

cp /Server/comm/cleoa/cnet/cnetr /Server/edliin?.fil

rm /Server/comm/cleoa/cnet/cnetr

Example start-up
command

3780Plus -d /dev/tty03 -j ./geis/geissr.job -k 18005551212 GEISID GEISPSWD -LO
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Troubleshooting 0

Communications Session Error Recovery

Introduction With communications applications, failures can occur. The communications 
scripts developed by Sterling Commerce are designed to handle common 
communications errors. 

Error messages
and end codes

The communications script files (<van>sr.job files), have an “error Fall Thru” 
section. This section lists the messages that the Cleo application writes to the .log 
file. Each time a session error occurs, the .job file posts a relevant error message 
to the log and returns an end code when it exits the Cleo application. You can use 
this end code in a shell script (UNIX) or .bat file (DOS/Windows) to decide 
whether communications ended successfully. An end code of 0 indicates success 
and a non-zero value indicates a failure. The various end code values indicate 
why the failure occurred. 

Sterling
Information

Broker Async
end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

(Continued on next page)

Sterling Information Broker Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Require further examination

35 Error occurred during dial attempts; connection never 
established.

50 Error occurred at some point during the logon process to 
the network. Connection established to communication 
node but no session established with host. 

60 Error occurred while attempting to transmit your 
outbound data to the network; resend data.

70 Error occurred while attempting to receive inbound data 
or reports from the network; any data to be sent during 
that session was NOT sent; retry may be required.
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Sterling
Information

Broker Bisync
end codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

Advantis
Expedite/Direct

Async end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

Sterling Information Broker Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established.

40 Error occurred during receive process for inbound data 
or reports from the network; retry may be required.

50 Error may have occurred at some point during transmittal 
of ‘request cards’, ‘add’ card’, or outbound data file; retry 
may be required.

Advantis Expedite/Direct Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established.

40 Error occurred during logon process; session never 
established communication to Advantis network, even 
though connection was made. 

50 Error occurred during transmittal of outbound data to 
Advantis network.

55 Error occurred during transmittal of outbound flat file data 
to Advantis network.

(Continued on next page)
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Advantis
Expedite/Direct

Bisync end
codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

(Continued on next page)

60 Error occurred during reception of inbound data from 
Advantis network; retry may be needed.

65 Although data may have been collected by 
communications, Advantis may not recognize this 
because the session failed after the data was received; 
they may send duplicate data in following session. 

70 Logoff process failed and Advantis may not have 
collected or acknowledged your receipt of data.

 (Contd)
Advantis Expedite/Direct Async (A+)

End Code Meaning

Advantis Expedite/Direct Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to Advantis network even 
though connection was made.

50 Error occurred during transmittal of data.

55 Error occurred during transmittal of ‘receive’ and ‘receive 
log’ commands occurred, or acknowledgment from 
Advantis never received. 

60 Error occurred during receive process for inbound data 
file or reports from Advantis.
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GEIS
EDI*Express

Async end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

(Continued on next page)

GEIS EDI*Express Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Require further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to GEIS network, even 
though connection was made. 

50 Error occurred during transmittal of commands 
associated with sending outbound data to Advantis 
network; data never sent. 

55 Error occurred during transmittal of outbound data to 
GEIS network.

60 Error occurred during transmittal of receive commands 
for inbound data from GEIS network.

65 Error occurred during reception of data from GEIS 
network.

70 Error occurred during logoff.
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GEIS
EDI*Express

Bisync end
codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

GEIS EDI*Express Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to GEIS network even 
though connection was made.

50 Error occurred during transmittal of commands 
associated with sending outbound data to Advantis 
network; data was never sent. 

55 Error occurred during transmittal of outbound data to 
GEIS network.

60 Error occurred during transmittal of receive commands 
for inbound data from GEIS network, or failure occurred 
receiving data from GEIS network. 

65 Error occurred during transmission of  *EOS command; 
session may not even be recorded on GEIS network 
side.
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Cleo 3780Plus Troubleshooting

Introduction This section offers possible solutions to three of the most common situations. See 
your Cleo documentation for further information.

Problem and
solution table

This table lists common problems and solutions.

Problem Possible Solution

During a RECEIVE process, 
you encounter a WAIT error.

Increase the Wait Limit parameter in the Cleo 
configuration file (cnet.cfg, adv.cfg, or geis.cfg).

During a SEND process, you 
encounter a RETRAN error.

Increase the Retransmission Limit parameter in 
the Cleo configuration file (cnet.cfg, adv.cfg, or 
geis.cfg).

At any point in the session, 
you encounter a BIDLMT 
error.

Check the documentation for your modem and 
verify that it can handle synchronous 
communications, then try again. 

If the problem continues, contact Cleo Support 
of Sterling Commerce Customer Support for 
information and assistance.

Note
The BIDLMT error can occur when you attempt 
to connect to a bisynchronous line at a speed 
other than that of the line. For example, if you 
attempt to connect to a 9600 bisynchronous line 
at 2400 baud. 
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Connecting to Other VANs and Directly to Trading 
Partners

Introduction If you need to connect to a trading partner directly or to a VAN that is not 
supported by the Communications Toolkit, you will need to create a Cleo 
communications script to connect to the VAN. You may also need to create a 
configuration file.

About creating
communications

scripts

Scripts are usually created as ASCII text files, which you do not need to compile.

Cleo 3780Plus The Cleo 3780Plus communications application software enables an ASCII 
system to emulate a 2780 or 3780 terminal. With 3780Plus, you can transmit and 
receive data from any system that supports the 2780 or 3780 bisynchronous 
protocols.

The scripting facility in Cleo 3780Plus is relatively simple to use. However, you 
must understand the session protocol that the remote system requires.

(Continued on next page)
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Basic Cleo
3780Plus

commands

The table below lists some basic Cleo commands and descriptions. See your Cleo 
3780Plus documentation for more detailed information.

Command Description

AUTODIAL tel# Txx Rxx Used to dial remote system’s modems for a 
communications connection.

◗ tel# = The number to connect to.
◗ Txx = The timer delay for waiting for an answer 

from the remote modem.
◗ Rxx = The retry parameter for number of 

attempts to retry if the dial attempt fails.

KEY msg -ENRX Used to send a user a specified message. Often 
used to send commands such as a system logon to a 
remote system. Unless otherwise specified, Cleo 
automatically transmits an End of Transmission 
(EOT) character when the message transmission is 
complete.

The switches that follow the command are used for 
protocol and translation functions. 

◗ -E = Suppress an EOT character after the 
message is transmitted.

◗ -X = Suppress an End of Text (ETX) character as 
well as an EOT character after the message is 
sent.

◗ -N = Send non-transparent data from the 
message through “as is” (no translation).

◗ -R = Suppress inter-record separators from the 
transmitted message.

TEXT path/filename -
ENRX

Used to transmit specified files to the remote system. 
The switches that follow the command (-ENRX) are 
used for protocol and translation functions. See 
descriptions above.

(Continued on next page)
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Suggestions ◗ Reference the 3780Plus documentation to learn about the many other 
session script commands, startup options, and other functions not discussed 
in this appendix.

◗ Make sure you are familiar with all the options on the commands before you 
use them.

◗ Use the 3780.LOG file to review sessions for errors that may have occurred 
during the previous communications sessions.

◗ There is a Monitor file you can use as a line scope to determine what is being 
transferred to and from your system. This monitor is in EBCDIC Hexadecimal 
code. There is a conversion chart in the 3780Plus documentation that may 
help you read this trace.

Cleo A+ Cleo A+ enables users to transmit and receive files from systems that support 
asynchronous file transfer protocols. You can run sessions interactively or use 
scripts you have written to perform unattended functions. Several configuration 
options are available for file transfer: ASCII, Xmodem, Ymodem, Zmodem, 
Kermit, ANSI, and FTP (slip, ppp, telnet).

The scripting facility in Cleo 3780Plus is relatively simple to use. However, you 
must understand the session protocol that the remote system requires. A+ allows 
use of environment variables, user-defined variables, and the ability to control file 
naming during a session.

(Continued on next page)

RECEIVE path/filename -
NX

Used to receive files from the remote system to a 
specified path and filename. A received EOT 
character terminates the command. A received ETX 
character causes Cleo to terminate the write to the 
specified file and start writing into an incremented 
filename. Depending on the user filename, Cleo may 
overwrite the previous data in the specified file.

Switches:

◗ -X = Ignore incoming ETX characters
◗ -N = Allow transparent data to be received “as is” 

(no translation)

VOICE Hangs up the phone and terminates a session. 
Usually, the command to terminate the Cleo 
3780Plus application (QUIT) follows this command.

 (Contd)
Command Description
Getting Started Guide - March 2011



Connecting to Other VANs and Directly to Trading Partners Setting Up Communications2 - 30
Basic Cleo A+
commands

This table includes descriptions of basic Cleo A+ commands used to start a 
dialup, send commands to a remote system, receive files, send files, and 
terminate the connection. See your CleoA+ documentation for more detailed 
information.

Command Description

AUTODIAL tel# Txx Rxx Used to dial remote system’s modems for a 
communications connection.

◗ tel# = The number to connect to
◗ Txx = The timer delay for waiting for an answer 

from the remote modem
◗ Rxx = The retry parameter for number of 

attempts to retry if the dial attempt fails

KEY msg -NTR Used to send a user a specified message. Often 
used to send commands such as a system logon to 
a remote system. Unless otherwise specified, Cleo 
automatically transmits a CR character when the 
message transmission is complete.

The switches that follow the command are used for 
protocol and translation functions. 

◗ -N= Send non-transparent data from the 
message through “as is” (no translation).

◗ -T= Force message through the translation 
table.

◗ -R= Suppress carriage return (CR) from the 
end of the transmitted message.

SEND path/filename / 
remote filename -TN

Used to transmit specified files to the remote 
system. The remote filename parameter is used to 
send the same filename to the remote system. The 
switches that follow the command (-TN) are used 
for translation functions.

◗ -T= Force message through the translation 
table.

◗ -N= Send non-transparent data from the 
message through “as is” (no translation).

(Continued on next page)
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Suggestions ◗ Reference the A+ documentation to learn about the many other session script 
commands, startup options, and other functions not discussed in this 
appendix.

◗ Make sure you are familiar with all the options on the commands before you 
use them.

◗ Use the A+.LOG file to review sessions for errors that may have occurred 
during the previous communications sessions.

Configuration
file

Depending on your partner’s requirements, you may need to create a 
configuration file. The important thing to remember is that the settings defined in 
the configuration file that pertain to your system or your modem should always be 
in sync with each other. Be sure to talk to staff at the remote site to determine its 
requirements for connection. Never assume anything will work. Even if you guess 
on how to establish the connection you will still need to determine the session 
protocol. Talk to your remote staff!

(Continued on next page)

RECEIVE path/filename -
NT

Used to receive files from the remote system to a 
specified path and filename. Depending on the file 
transfer type you are using, when the receive is 
complete, A+ attempts to write to the specified file 
or into an incremented filename. A+ may overwrite 
the previous data in the specified file, depending 
on the filename.

Switches:

◗ -N= Allow transparent data to be received “as 
is” (no translation).

◗ -T= Force the outbound data through the 
translation table.

VOICE Hangs up the phone and terminates a session. 
Usually, the command to terminate the Cleo 
3780Plus application (QUIT) follows this 
command.

 (Contd)
Command Description
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Extended
Communications

Support
Services (ECS)

If you do not have the resources required to develop the communications or 
configuration file, Sterling Commerce offers consulting services to create, 
maintain, install, and test communications. Contact Sterling Commerce Customer 
Support and ask for communications support for information.
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Introduction

Welcome Welcome to Gentran:Server®, the electronic data interchange (EDI) software that 
makes it easy to manage data exchanges between you and your trading partners. 
The heart of EDI is the translation of data into and out of formats that are 
intelligible to computerized data management systems. 

Gentran:Server enables you to exchange data with your trading partners. When 
you send application data, Gentran:Server converts your data into EDI standard 
formats that can be understood by your trading partners. When you receive data 
in a standardized format, Gentran:Server translates the data into a format your 
application can understand.

You can use Gentran:Server to describe your applications, edit standards, 
maintain trading partnership information, and generate translation “maps,” which 
are sets of instructions for translating data.

Note
If your company purchased the XML translation option, you can also 
exchange data in XML format. See the Gentran:Server for UNIX and 
Workstation XML User’s Guide for more information.

In this chapter This chapter contains background information about Gentran:Server that you 
should know before beginning to use the software.

Key terms This table describes key terms used in this chapter.

Term Description

application The business software generating the business 
information that you are sending or receiving 
electronically.

default A value that is automatically assigned.

EDI Electronic Data Interchange.

Application-to-application transfer of key business 
transaction information in a standard or XML format via a 
computer-to-computer communication link.

(Continued on next page)
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EDI standard A format to regulate syntax, structure, and content of 
transaction data.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI 
document and the data fields in your application

◗ The elements in an XML document and the data 
fields in your application, EDI standard document, or 
in another XML document

◗ The segments and elements of two different 
standards

◗ The records and fields of two different applications

master directory The directory on a PC that stores your master files.

master file The version of a map that Gentran:Server uses to 
process data. 

standard format A format intelligible to computerized data management 
systems.

temporary file A file on the client that Gentran:Server uses during 
editing and compiling.

trading partner The company, division, or group with which you are 
exchanging business data electronically.

Trading Partnership An arrangement to exchange information in a specific 
document type with a specific trading partner and using a 
particular standard version.

working file A file that is stored in the user’s working directory on the 
client while the user has it checked out for editing.

working file directory The directory created on the client to hold the files that a 
user is editing.

 (Contd)
Term Description
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Gentran:Server Features

Introduction This summary lists the features Gentran:Server provides for your translation 
needs.

Product versions There are two basic versions of Gentran:Server:
◗ Gentran:Server Workstation, which runs on a PC
◗ Gentran:Server for UNIX, which runs on a client/server architecture

Gentran:Server
Workstation
architecture

The Workstation architecture provides:
◗ A Windows® interface.
◗ All files and processing on one machine.
◗ Single-user configuration; no file-sharing or security limitations.
◗ Standard Gentran:Server functions.

Multiple Help
sources

Gentran:Server provides Help through:
◗ Wizards to guide you through the key record-creation processes.
◗ Online Help with task-oriented content.
◗ Documentation provided on CD-ROM for online access.

Automated
functions

The following features automate many tasks for you.

Archiving
◗ Stores and retrieves both EDI and user-defined data
◗ Tracks key EDI activities; provides reports and audit trails of translations

Functional Acknowledgments
◗ Handles inbound and outbound functional acknowledgments and 

reconciliation
◗ Provides status information for each document

Task Scheduler
◗ Runs processes such as upload and download, translation, communications, 

and other tasks in a totally unattended mode

(Continued on next page)
Getting Started Guide - March 2011



Introducing Gentran:Server Gentran:Server Features 3 - 5
Mappers There are two mappers available in Gentran:Server 6.1:

◗ the Application Integration subsystem (Application Integration Mapper)
◗ the Visual Mapper

Reference
See the topic Gentran:Server Mappers for a comparison of the Application 
Integration Mapper and the Visual Mapper.
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Gentran:Server Mappers

Introduction This topic discusses the differences between the Application Integration Mapper 
and the Visual Mapper.

Which mapper to
use

Gentran:Server 6.1 is available to new and existing customers. The mapper you 
use depends on the version of Gentran:Server your company used before 
purchasing Gentran:Server 6.1. Refer to the following table to determine which 
mapper you will use.

Illustration The illustration identifies the Application Integration Mapper and the Visual 
Mapper buttons.

Creating maps If both the Application Integration Mapper and the Visual Mapper are available to 
you, then you can create maps in either mapper. However, you cannot create a 
map in one mapper and save it to the other. Similarly, you can only open a map in 
the mapper in which it was created.

(Continued on next page)

IF your company… THEN use…

purchased Gentran:Server for 
the first time

the Application Integration Mapper (AI).

upgraded from 
Gentran:Server version 5.4

the Application Integration Mapper (AI).

upgraded from 
Gentran:Server version 5.3 or 
prior

the Application Integration Mapper (AI) to 
create new maps and the Visual Mapper 
(MAP) to maintain your current maps.

Visual Mapper buttonApplication Integration 
Mapper button
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Extensions This table lists the map and associated file extensions.

WARNING
If you are using both the Application Integration Mapper and the 
Visual Mapper, you must be careful NOT to overwrite your .vmp map. 
If the master directory contains a map with the same name as your 
working map, then you must use a different name for your working 
map. This prevents the .map file from overwriting the .vmp file. 
For example, if you are creating a new map in the Application 
Integration Mapper using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
Gentran:Server does not recognize map extensions. When you check 
in a working map to the master directory, it overwrites any existing 
map file that has the same file name, regardless of the extension.
When you upgrade, all .map files are converted to .vmp files (5.3 
users or prior). 

(Continued on next page)

IF the map is created 
using the…

THEN the map 
extension is…

AND the associated 
file extension is…

Application Integration 
Mapper

.map .TPL

Visual Mapper .vmp .TBL
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Terminology:
Different terms

with same
definition

In many instances, the Application Integration Mapper and Visual Mapper use the 
same terms and meanings. However, there are instances in which two different 
terms share the same definition. The following table lists the common definitions 
with the corresponding terms.

lftran options Both the Application Integration Mapper and the Visual Mapper interface with 
lftran (a Gentran:Server translator), but the options available are different.

Reference
See the Gentran:Server for UNIX and Workstation Technical Reference 
Guide for more information.

Definition
Application Integration 

Mapper Term Visual Mapper Term

The standard transaction 
set Gentran:Server uses 
to acknowledge receipt 
of a transmission. The 
functional 
acknowledgement tells 
you if your trading 
partner received a 
document you sent.

Acknowledgement Functional 
acknowledgement

A file that defines the 
layout of the records, 
fields, and groups in an 
application file.

File definition (.ddf) Application description 
(.app)

The file that results when 
a map is compiled.

Translation object (.tpl) Mapping table file (.tbl)

Compiled map

A file that shows the 
relationships between 
input and output and 
defines how the system 
should translate the 
data.

map (.map) Map File (.vmp)
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Gentran:Server Workstation Strategy

Introduction This topic describes the Gentran:Server Workstation architecture.

Description All Gentran:Server Workstation files are installed on a PC. The PC stores the 
data, houses the user interface, and runs the processes. 

Advantages The Workstation architecture provides the following advantages:

◗ Allows users familiar with PCs to quickly learn how to use the Gentran:Server 
interface

◗ Provides a single-user control over data and processes
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Running Multiple Sessions

Definition A session is a single instance of the Gentran:Server application running in a 
window on your desktop.

Gentran:Server does not limit you to a single session; you can run more than one 
instance of Gentran:Server for UNIX client software or Gentran:Server 
Workstation at the same time. Each time you start Gentran:Server on your 
desktop, you start a new session. Each session runs in a different window. 
Running multiple sessions enables you to perform different Gentran:Server tasks 
in each window.

How many
sessions can

you run?

You can run:

◗ Up to four sessions of the Gentran:Server for UNIX client software at the 
same time on one Windows desktop

◗ Up to four sessions of Gentran:Server Workstation at the same time on one 
Windows desktop

◗ Gentran:Server Workstation and Gentran:Server for UNIX client software at 
the same time on one desktop.

Example
You run three simultaneous sessions of the Gentran:Server for UNIX client 
software for the host1 and environment XYZ combination:

◗ Session 1, view a file with the File Browser
◗ Session 2, search for a Trading Partnership record
◗ Session 3, create a new category

Performance
limitations

Each additional session you start degrades performance. Opening too many 
sessions at once can cause the client to lock.

Login
requirements for

UNIX

When you start another Gentran:Server session for a host and environment that is 
running on your desktop, you must use the same User Name and Password to log 
onto the new session.

If you want to start a session for a different host or environment, you can use a 
different User Name and Password.

(Continued on next page)
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Process and
session limits

If you open multiple sessions on your desktop, the sessions can be for the:

◗ Same host and environment (Gentran:Server for UNIX)
◗ Same host and different environments (Gentran:Server for UNIX)
◗ Different hosts and environments (Gentran:Server for UNIX)
◗ Combination of Gentran:Server Workstation sessions and Gentran:Server for 

UNIX sessions.

This table shows the limitations on running processes in multiple sessions.

(Continued on next page)

Process Limitations

File Browser None. Multiple windows permitted in each 
session.

Trading Partnership Maintenance None. Multiple windows permitted in each 
session.

Process Control Manager (if 
included)

Once in a session for each host/
environment combination.

SAP Configuration (if purchased) Once in a session for each host/
environment combination. 

Standard Version Conversion (if 
purchased)

Once in a session for each host/
environment combination.

Archive Once in a session for each host/
environment combination.

EC Workbench (if purchased) One client session for each host/
environment combination.

You can run EC Workbench multiple times 
as long as each Client session is for a 
different host/environment combination.

Translation One client session for each host/
environment.

You can run translation multiple times as 
long as each session is for a different host/
environment combination.

Map Compilation One client session at a time.

Mapping None. Multiple windows permitted in each 
session 
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If a process has session limitations and is already running, Gentran:Server 
displays a message to let you know that the process is busy and asks that you try 
again later.

File locking Gentran:Server locks certain files to prevent you from editing the same file in 
multiple sessions. If you attempt to edit a file that you are editing in another 
session, Gentran:Server displays a message to let you know that the file is in use.

Gentran:Server locks these files when you open them for editing:

◗ Maps
◗ Trading Partner record
◗ Group Organization record
◗ Interchange Organization record

Exceptions
Locking does not apply to:

◗ Files edited in the File Browser
◗ Trading Partnership Category files
◗ Trading Partnership Contact files

Note
If the same non-DISAM file is edited in two different parallel sessions, the 
last changes saved overwrite earlier changes from another session.

Caution
Never use the File Browser to edit a DISAM (*.dat and *.idx pair) file. Doing 
so will corrupt the file. 

Report, log and
local temporary

files

Gentran:Server keeps the report files, log files, and local temporary files for each 
host and environment in different directories.

The system creates a directory named rpt for the report and log files under the 
directory where the Gentran:Server client software is installed. The local 
temporary working files are stored in the lcltmp directory.

For each host and environment, the system creates a subdirectory under the rpt 
and lcltmp directories. The subdirectory is named for the environment and host 
name (environment+hostname) logged in to for the session.

(Continued on next page)
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Example
The Gentran:Server client software is installed in D:\gentran. The system 
creates subdirectories for the report files and for the local temporary files:

◗ D:\gentran\rpt
◗ D:\gentran\lcltmp
You start a session, logging in to the 60test environment on the host 
hpd350. Gentran:Server creates subdirectories for the session:

◗ D:\gentran\61testhpd350
◗ D:\gentran\rpt\61testhpd350
◗ D:\gentran\lcltmp\61testhpd350

Gentran:Server stores the session’s report and log files in 
D:\gentran\rpt\61testhpd350 and stores the session’s local temporary files in 
D:\gentran\lcltmp\61testhpd350.

You open a session for a different environment and host, 2XF on hpd001. 
Gentran:Server creates new subdirectories for the report and local temporary 
files:

◗ D:\gentran\2XFhpd001
◗ D:\gentran\rpt\2XFhpd001
◗ D:\gentran\lcltmp\2XFhpd001

Note
If the host or environment name contains special characters (such as *, ?, 
<, or >), the system converts the special characters to underscores (_). For 
example, the host name hp<200> is converted to hp_200_.
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File Name Conventions

Introduction This topic describes the file name conventions and limitations you must follow 
when you name a Gentran:Server file or directory.

Directory and
path name

length

Directory names can be up to 63 characters in length, not counting the slash or 
backslash character used to separate a directory name from a subdirectory name.

The total maximum for a path, file name, and file name extension is 128 
characters.

Validation When you save or open a file, Gentran:Server checks the length of the file name 
and the characters used in the file name. If the file name exceeds the maximum 
length or if the file name includes an invalid character, Gentran:Server displays a 
message to alert you of the problem.

(Continued on next page)
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File name length This table lists length restrictions of the file names of specific types of 
Gentran:Server files:

(Continued on next page)

File Type Maximum Length of Name

Map 60 (plus 4-character extension)

File definition 60 (plus 4-character extension)

Application description 60 (plus 4-character extension)

Implementation guide 60 (plus 4-character extension)

Input file 60 (plus 4-character extension)

Output file 60 (plus 4-character extension)

Mapping table 60 (plus 4-character extension)

Script 14 characters

Data manager 4 characters

Data manager pattern 15 characters

Transaction Register 9 characters

Queue 8 characters
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Character
limitations

This table lists the characters that Gentran:Server does not allow in a file name.

Character Description

\ Backslash (reserved for separating directory, subdirectory, and 
file names)

/ Slash (reserved for separating directory, subdirectory, and file 
names)

* Asterisk

“ Double quotation mark

‘ Forward single quotation mark

' Backward single quotation mark

< Less-than sign

> Greater-than sign

| Vertical bar

Spaces

@ “At” sign

& “Ampersand” character

( Open round bracket

) Closed round bracket

; Semi-colon

: Colon

? Question mark

$ Dollar sign
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Introduction

In this chapter This chapter contains general information about the Gentran:Server interface. It 
describes the menus and Toolbar of the Main Window and includes instructions 
for:

◗ Starting and exiting Gentran:Server
◗ Using menus, toolbar buttons, and dialog boxes
◗ Using the File Browser to edit text, EDI, and NCPDP files
◗ Choosing printing properties
◗ Setting Gentran:Server preferences and default values

Key terms This table describes key terms used in this chapter.

Term Description

check box A square to the left of an option in a dialog. When the 
option is selected, the square contains an X. You click 
the check box to change whether the option is selected. 

default A value that is automatically assigned.

master directory The directory on a PC  that stores your master files.

menu A list of related commands.

menu bar The row of menu names that runs across the top of a 
window.

option button A round button used to select one option from a mutually 
exclusive set of options.

push-button A symbol or icon that initiates some action when you 
click it.

text box A box into which you enter alphanumeric text to provide 
data needed by Gentran:Server.

Toolbar A bar of buttons used to start commands.
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Starting and Exiting 0

How to Start Gentran:Server Workstation

Introduction This topic explains how to start Gentran:Server Workstation.

Note
You can run up to four sessions of Gentran:Server on the same desktop at 
once.

Procedure Follow this procedure to start Gentran:Server Workstation. 

Reference
See the How to Set TP Administration Preferences topic in the 
Gentran:Server for UNIX and Workstation Application Integration User’s 
Guide for instructions on setting Trading Partnership Administration 
Preferences.

Step Action

1 Click the Windows Start menu.

2 Select the Gentran:Server program icon from the Programs menu.

System Response
Gentran:Server displays the copyright dialog box.

3 Click OK.

System Response
Gentran:Server displays the Main Window.
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How to Exit Gentran:Server

Introduction This topic explains how to exit Gentran:Server.

Before you exit Any files that are checked out when you exit the application remain checked out 
and unavailable for other users to edit. Before you exit Gentran:Server, be sure to 
check in any files that you no longer need. 

Reference
See How to Check In Maps and Translation Objects and How to Check In 
File Definitions in the Working with Application Integration chapter or How to 
Check In Compiled Maps, How to Check In IG/Application Description Files, 
and How to Check In Synonym and Thesaurus List Files, in the Working 
with Visual Mapper chapter for instructions.

Procedure Select Exit from the File menu.

Note
If you are running multiple sessions on your desktop, you must exit each 
session.

System Response
Gentran:Server Workstation exits.
Getting Started Guide - March 2011



Using Gentran:Server Overview 4 - 5
The Gentran:Server User 
Interface 0

Overview

Introduction Gentran:Server features on the client use the Windows environment. To use 
Gentran:Server, you must be familiar with using a personal computer and with 
Windows functions and terminology, including the following:

◗ The terminology used to describe mouse and cursor actions; for example, 
opening, clicking, scrolling

◗ The terminology used to describe Windows-specific attributes, such as dialog 
boxes, buttons, and check boxes.

User interface The user interface for all versions of Gentran:Server includes:

◗ Screens that use the familiar Windows interface.
◗ Graphical tree organization of trading partnership records to make setup and 

maintenance easier.
◗ Graphic displays of mapping components and relationships.
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The Main Window

Introduction This topic explains the items you see on the Gentran:Server Main Window.

Reference
Refer to your Windows documentation for detailed explanations of Windows 
terms and functions.

Main
Workstation

window

This illustration shows the major parts of the main window for Gentran:Server 
Workstation.

(Continued on next page)

 
Menu bar

Toolbar

Status bar
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Parts of the
window

This table describes the parts of the main Gentran:Server window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button description.
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Main Window Menus

Introduction You can start all Gentran:Server features and functions from the menus of the 
Gentran:Server Main Window.

Workstation
Main Window

menus

This table describes the menus of the Workstation Main Window.

Menu Used to…

File Menu ◗ Check in a file
◗ Check out a file
◗ Unlock a file
◗ Open the Print Setup dialog box
◗ Exit the Main Window

Edit Menu ◗ Start a mapping editor (Application 
Integration or the Visual Mapper)

◗ Start the Trading Partnership 
Administration subsystem

Translate ◗ Open the Translate Documents dialog box
◗ Generate a translation report.

Archive ◗ Set archiving parameters
◗ Open an archive
◗ Purge an archive
◗ Load and unload archived files
◗ Create new archives

XML Configuration (if you 
purchased the XML 
translation option)

◗ Open the XML Element Configuration 
window

◗ Start the XML Trading Partnership Rules 
wizard

◗ Open the XML TP Cross Reference dialog 
box.

(Continued on next page)
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Application File Configuration ◗ Start the Application File Trading 
Partnership Rules wizard

◗ Open the Application File TP Cross 
Reference dialog box.

Tools ◗ Set up and Run scheduled tasks
◗ Run Standard Version Conversion
◗ Start the File Browser
◗ Open the Run a Command dialog box to 

run a command line program

Settings Specify default directories for your 
Gentran:Server files

Window ◗ Display or hide the Toolbar
◗ Display or hide the Status Bar

Help ◗ Open the Help Contents or Index
◗ Display information about using Help
◗ Display version information for 

Gentran:Server

 (Contd)
Menu Used to…
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The Main Window Toolbar

Introduction The Gentran:Server Toolbar consists of several buttons that you can use to 
quickly access Gentran:Server subsystems, tools, and optional features.

The specific buttons displayed on your toolbar depend upon the Gentran:Server 
product level and options your company purchased. This topic describes the most 
common buttons. Your toolbar may include additional buttons for optional 
features.

The Main
Window Toolbar

To execute a command with a toolbar button, click the appropriate button. 

Click this… To do this…

Check in files.

Check out files.

Open the Application Integration mapping editor.

Open the Visual Mapper mapping editor.

 

Open the Trading Partnership Administration 
subsystem.

Open the Translate Documents dialog box or generate a 
translation report.

Start an archiving option.

Open the File Browser text editor.

Display Help for the current window.
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How to Use the Gentran:Server Interface

Introduction This topic explains how to use the Gentran:Server menus, toolbars, dialog boxes, 
and other interface features.

Using the menus To select a menu command, select the menu name to display the drop-down list of 
commands; then select the desired command. You can also select many 
commands from the keyboard by pressing the short-cut keys displayed to the right 
of the command or by pressing ALT + the underlined letter in the menu item name 
and then the letter underlined in the drop-down list.

Using the
Toolbar

To start a feature or subsystem from the Toolbar, click the appropriate 
Toolbar button.

Note
For information about a Toolbar button, place the pointer on the button to 
display the button’s name and then refer to the Status Bar for the button’s 
function.

(Continued on next page)
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Using the Status
Bar

The status bar displays information, descriptions, or instructions for the active 
window, item on a dialog box, toolbar button, or command. You may see a status 
such as “Ready” for a window, an instruction such as “Enter record ID” for a text 
box on a dialog box, or “File Browser” for a Toolbar button.

To use the Status Bar, move the pointer to the window, box, or button that you 
want to check and then read the text displayed on the Status Bar.

Using dialog
boxes

You enter information within a dialog box by:

◗ Typing in text boxes
◗ Selecting items from list boxes
◗ Clicking check boxes, options, or push buttons. 

To move to the desired box or button, use either the mouse or the keyboard.

◗ When using the mouse, move the mouse pointer to the desired box or button 
and click to select the box or button.

◗ When using the keyboard, press TAB to move to the next box or button or 
press SHIFT+TAB to move to the previous box or button.

Status bar
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How to Use the On-line Help

Introduction Gentran:Server provides Help information to guide you through commands and 
procedures. Gentran:Server’s Help files explain many topics: parts of the active 
window, commands, dialogs, and procedures for using specific features to 
perform a task.

Getting Help You can access Help several ways. The methods available depend on the window 
you have displayed. 

Using the Help
menu

To learn how to use Help, select Using Help from the Help menu. 

The Contents command form the Help menu displays a list of Help topics that you 
can choose from. You can access Help information for the topics in different ways; 
you can use the menus at the top of the Help window, or you can use the buttons 
under the menus to search for a topic. You can print and edit Help information.

(Continued on next page)

To start Help 
from… Do this…

The menu bar Select a command or topic from the Help menu. 

The toolbar Click the Help button on the toolbar for information about 
the currently displayed dialog box or window. 

Any window Press F1 for information about the window. 

A dialog box Click the Help button on the active dialog box for related 
help information. 
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Using the Help
toolbar button

On major windows, you can get window-level Help by clicking the Help button on 
the toolbar. 

Using the Help
buttons on

dialog boxes

You can get Help for any dialog box that displays the Help button. Click Help for 
more information. 

Exiting Help You can close the Help window when you are finished with it. To close Help, 
select Exit on the File menu of the Help system menu bar.

Help
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The File Browser

Introduction The File Browser is a Gentran:Server tool that enables you to open and edit text, 
EDI, and NCPDP files. It contains basic text-editing features, such as copying, 
cutting, pasting, finding, and replacing text.

When to use You can use the File Browser to open and edit:

◗ Text files, such as batch files (*.bat) and configuration files (*.cfg)
◗ EDI files
◗ NCPDP files

Note
When you open an EDI file in the File Browser, Gentran:Server runs the 
edifrmat command on the file before displaying it. The edifrmat command 
replaces the segment terminators in the file with new line terminators so 
that the format is easier to read.

CAUTION
Never use the file browser to edit a disam file. Doing so will corrupt 
the file.

The File Browser
window

This illustration shows the File Browser window.

(Continued on next page)
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Parts of the File
Browser window

This table describes the parts and functions of the File Browser window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button 
description.
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How to Use the File Browser

Introduction This topic explains how to start and exit the File Browser, open a file, and use the 
File Browser editing commands to modify a file.

Starting the File
Browser

To start the File Browser, do one of the following:

◗ Click the File Browser button on the Main Window toolbar.
◗ Select Start File Browser from the Tools menu.

Opening a file There are two ways to open a file in the File Browser: from the Toolbar or from the 
File menu.

Method 1 - Toolbar button.

Step Action

1 Click the Open button on the File Browser toolbar.

System Response
The File Browser displays the Open dialog box.

2 Select Text File, EDI File, or NCPDP File to indicate the type of file 
you want to open.

CAUTION
Never use the file browser to edit a disam file. Doing so 
will corrupt the file.

3 Click OK.

System Response
The File Browser displays the standard Open dialog box.

4 Browse to the folder and file you want to open.

5 Click OK.
(Continued on next page)
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Method 2 - File menu

Select Open from the File menu and then select Text, EDI, or NCPDP from the 
cascading menu.

Editing a file in
the File Browser

This table describes how to edit, print, and save a file in the File Browser.

6 IF you open… THEN the File Browser…

an EDI file displays the Enter EDI Format 
Parameter dialog box.

Continue with Step 7.

a text file displays the text file. You are 
finished. 

a NCPDP file runs the edifrmat command on 
the file you selected and 
displays the file in a newline 
terminated format.

You are finished.

7 Select the option on the Enter EDI Format Parameter dialog box to 
specify the format you want applied to the data.

System Response
The system runs the edifrmat command on the file you 
selected and displays the file in a newline terminated format.

 (Contd)
Step Action

IF you want to… Then…

Insert characters Click at the insertion point and type the 
characters.

Copy selected text to the 
clipboard

Click Copy on the Edit menu.

Paste text on the clipboard 
into the document

Click at the insertion point and then click Paste 
on the Edit menu.

Select the entire document Click Select All on the Edit menu.
(Continued on next page)
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Exiting the File
Browser

To close the File Browser, do one of the following:

◗ Select Exit from the File menu.
◗ Click the close button on the File Browser window.

Search for characters, words, 
or phrases

Click Find on the Edit menu. Then, enter the 
search string.

Search for the next 
occurrence of a search item

Click Find Next on the Edit menu.

Replace selected text Click Replace on the Edit menu. Then type the 
replacement text.

Print the document Click Print on the File Menu.

Save the changes to the 
document

Click Save on the File menu.

Save a copy of the document 
under a new path or name

Click Save As on the File menu. and enter the 
new path and file name.

 (Contd)
IF you want to… Then…
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How to Change Print Properties

Introduction This topic explains how to open the Print Setup dialog box from within 
Gentran:Server. Check your Microsoft® documentation for details on how to use 
the window.

Background When you print any of the reports that Gentran:Server generates, the program 
prints the report on the default printer, using the default font style and size 
specified for that printer. You can use the Microsoft Print Setup dialog box to 
specify print properties for the default printer for the client. 

Your selections affect all printing (except printing of compiler messages) in 
Gentran:Server until you quit or change them. If you want to set these defaults 
and keep them between Gentran:Server sessions, use the Printers utility in the 
Windows Control Panel.

Opening the
Print Setup

window

Follow this procedure to open the Print Setup dialog box from within 
Gentran:Server.

Adjusting print
properties

Depending upon the font style and size, some parts of the report may not appear 
on the output (This may be a problem with fonts larger than 12 point). To correct, 
change the default font style or size. The methods of changing the default font 
style and size vary according to your PC. 

Depending upon the aspect ratio of the report, you could also try printing 
landscape instead of portrait. 

Step Action

1 Click File on either the Main, Application Integration Main, Visual 
Mapper, Application Editor, or Standard/IG Editor menu bar.

2 Click Print Setup on the File menu.
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Setting Default Values 0

Overview

In this section This section explains how to set the basic directory and the Application Integration 
Mapper and Visual Mapper preferences and default values you want your system 
to use.

Reference
See the Setting Preferences and Default Values section in the 
Gentran:Server for UNIX and Workstation Application Integration User’s 
Guide for information about setting preferences and default values for the 
Application Integration subsystem.

See the Specifying Preferred Default Values section in the Gentran:Server 
for UNIX and Workstation Mapping and Translation Guide for information 
about setting preferences and default values for the Visual Mapper.

Default
directories

The Set Up Directories dialog box enables you to define the default directories 
that Gentran:Server will use to store your Gentran:Server files on your PC or 
client. 

When to set the
values

We recommend that you set your default directory and map display values before 
you create your first map. However, you can set or change the map display 
options at any time.

(Continued on next page)
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Where to go next Use this table to locate the instructions for setting particular types of preferences.

IF you want to customize… THEN select…

Workstation

The default directories your 
system uses to store 
Gentran:Server files

How to Change the Default Workstation 
Directories.

Application Integration

All the Application Integration 
Subsystem preferences

How to Set the Application Integration 
Preferences in the Gentran:Server for UNIX 
and Workstation Application Integration User’s 
Guide.

The list of date and time 
formats that you can use in 
map fields

How to Set the Application Date/Time Formats 
in the Gentran:Server for UNIX and 
Workstation Application Integration User’s 
Guide.

The default date format for all 
date fields used in a map

How to Set the Default Date Formats in the 
Gentran:Server for UNIX and Workstation 
Application Integration User’s Guide.

Which map component 
descriptions are displayed

How to Customize Component Display 
Options in the Gentran:Server for UNIX and 
Workstation Application Integration User’s 
Guide.

Foreground and background 
colours of map components

How to Customize Component Colours in the 
Gentran:Server for UNIX and Workstation 
Application Integration User’s Guide

Font type, style, or size used 
in map displays

How to Customize Global Fonts in the 
Gentran:Server for UNIX and Workstation 
Application Integration User’s Guide.

How map links are displayed How to Customize the Display of Links in the 
Gentran:Server for UNIX and Workstation 
Application Integration User’s Guide.

How the map version number 
is incremented

How to Customize the Auto-increment Map 
Version in the Gentran:Server for UNIX and 
Workstation Application Integration User’s 
Guide.
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Visual Mapper

The Visual Mapper 
preferences

Specifying Preferred Default Values in the 
Gentran:Server for UNIX and Workstation 
Mapping and Translation Guide.

IF you want to customize… THEN select…
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Set Up Directories Dialog Box

Introduction The Set Up Directories dialog box enables you to define the default directories 
that Gentran:Server will use to store your Gentran:Server files on your PC.

Gentran:Server
Workstation

This illustration shows the Set Up Directories dialog box for Gentran:Server 
Workstation.

Note
The implementation guide directory is shaded and unavailable if you do not 
have the Visual Mapper installed.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Workstation Set Up Directories dialog box and their 
functions.

Field Function

Standards Stores a list of available standards. 

Note
If you have Visual Mapper capabilities, then 
this directory also stores the actual standards.

Implementation Guide Stores implementation guides (.igs). 

Note
The Implementation Guide directory 
unavailable if the Visual Mapper is not installed 
on your computer system.

File Definitions/Apps Stores file definitions (.ddfs). 

Note
If you have Visual Mapper capabilities, then 
this directory also stores the application 
description files.

Maps Stores map files and translation objects. 

Trading Partner 
Records

Stores Trading Partnership files. 

EDI Status Audit Stores the status audit files that Gentran:Server 
generates. 

EDI History Audit Stores the history audit files that Gentran:Server 
generates. 

User Files Stores your user files. 

Text/Help Files Stores text files and the Gentran:Server Help files. 

Data Files Stores your data files. 

Report/Log Contains the reports and log files that 
Gentran:Server generates. 

Default Check In/Out Serves as the default working directory for files. 

Default TPL/TBL 
Location

Serves as the default working directory for translation 
objects (compiled maps). 
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How to Change the Default Workstation Directories

Introduction You can change the default directories for the Gentran:Server files from the 
values set at installation. 

Changing
Workstation

directories

Use this procedure to change a directory path for the Gentran:Server Workstation 
files.

Step Action

1 Click Settings on the menu bar.

2 Click Set Up Directories on the Settings menu.

System Response
The system displays the Set Up Directories dialog box.

3 Click in the appropriate text box.

4 Delete the current path and type the new path, or edit the existing 
path as appropriate.

Note
You can use the browse button to the right of the box to 
browse for the path.

5 Click OK to save your changes. 
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Overview 0

Introduction

In this chapter This chapter contains information about working in Workstation and accessing 
and returning files.

Key terms This table describes the key terms used in this chapter.

Term Description

check in The act of returning a copy of a file from your 
working directory to the master directory, 
making it available to other users.

check out The act of copying a file from the master 
directory to your working directory, making the 
file unavailable to other users.

lock The act of making a file unavailable to other 
users. A file is locked once it is checked out.

unlock The act of making a file available to other 
users. A file is unlocked once it is checked in.
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Working in Workstation

Introduction Gentran:Server Workstation uses numerous data files such as maps, translation 
objects (.TPL files), file definitions (.ddf files), and Trading Partnership records.

This section explains how to work with files in Gentran:Server Workstation.

Master directory Gentran:Server Workstation stores the master files (maps, translation objects, file 
definitions, etc.) on the PC in the master directory specified for the file type. You 
specify the master directories in the Set Up Directories dialog box, which is 
available from the main Gentran:Server window under the Settings menu.

File checkout When you want to edit a master file, you must check it out. When you check out a 
map file to edit it, Gentran:Server Workstation moves a copy of the file to the 
working directory and retains the original file in the master directory.

Working
directory

Gentran:Server Workstation stores your working files (copies of checked out 
maps and file definitions) in the working directory on the PC. This enables you to 
modify a checked-out map without affecting the original file. You specify the 
working directories in the Set Up Directories dialog box, which is available from 
the Gentran:Server Settings menu.

Map check in When you check in a map file, Gentran:Server Workstation transfers a copy of 
the file from your working directory to the master directory. If the map file is one 
that you checked out, Workstation replaces the map in the master directory with 
the working copy. The working copy becomes the new master file for the map. 
Gentran:Server lets you to choose to keep or remove the copy of the file in your 
working directory.
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Dialog Boxes 0

Select Map and File Definitions Files to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Check out
◗ Select File Definition Files to Check out

Purpose The Select <filename> to Check out dialog box is used to move a copy of a file 
from the master directory to a working directory on the PC. Maps, and their 
associated TPL files, and file definitions files can be checked out.

Example check
out dialog box

The same dialog box format is used to check out file definition files.

This illustration shows the Select Map Files to Check out dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps created in both the Application Integration 
Mapper and the Visual Mapper with the extensions .map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check Out and Select File 
Definition Files to Check out dialog box and their functions.

Field Function

 …files from Displays the name of the master directory.

The list below the name displays the names of the files 
in the master directory. An asterisk next to a name 
indicates that the file is currently checked out.

Check out <filename> 
files to

Displays the name of the default working directory on 
your PC. This is the directory to which Gentran:Server 
copies the file.

The list below the directory name displays the names 
of the working files in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected file to the list of files in 
the working directory.

Remove Removes the name of the file from the working 
directory check out list.

Add All Adds the names of all the files in the master directory 
to the working directory.

Remove All Removes the names of all the files from the working 
directory check out list.

Edit Mode Checks out the files so that you can edit them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory. 

View Mode View Mode is unavailable in Workstation.
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Select Map Files to Check in Dialog Box

Introduction This topic describes the Select Map Files to Check in dialog box.

Purpose The Select Map Files to Check in dialog box is used to move the saved working 
file from your working directory to the master directory. The system replaces the 
master file with the map you check in. The following files can be checked in:

◗ map files 
◗ associated TPL files

Example check
in dialog box

This illustration shows the Select Map Files to Check in dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper 
capabilities, then the dialog box will list maps created in both the Application 
Integration Mapper and the Visual Mapper with the extensions .map and 
.vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check in dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps in the working directory.

Note
You can use the browse button to select a 
different directory.

Check in Map files to Displays the name of the master directory for maps on 
your PC. This is the directory to which Gentran:Server 
copies the map file.

The list below the directory name displays the names 
of the maps in the master directory.

Add Adds the name of the selected map to the list of maps 
in the master directory.

Remove Removes the name of the map from the master 
directory check in list.

Add All Adds the names of all the maps in the working 
directory to the master directory.

Remove All Removes the names of all the maps from the master 
directory check in list.
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Select TBL/TPL Files to Check In Dialog Box

Introduction The Select TBL/TPL Files to Check In dialog box is used to select the translation 
objects (compiled maps)  you want to check in.

Illustration This illustration shows the Select TBL/TPL Files to Check In dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper 
capabilities, then the dialog box will list maps and associated files created in 
both the Application Integration Mapper and the Visual Mapper with the 
extensions .map (TPL) and .vmp (TBL) respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select TBL/TPL to Check In dialog box and their 
functions.

Field Function

List of Map files to 
check in from 
directory

Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps you are checking in.

List of associated 
TBL/TPL files to 
check in with

Displays the names of the translation objects 
associated with the maps you are checking in. 

Finish Saves your changes and checks in the maps and 
translation objects you selected.
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Select File Definition to Check in Dialog Box

Introduction The Select File Definition Files to Check in dialog box is used to move a working 
copy of a file definition file (.ddf) from your working directory to the master 
directory for file definitions.

Illustration This illustration shows the Select File Definition Files to Check in dialog box.

Note
When you check in a file, the system converts the filename to lowercase letters. 
UNIX client/server versions require that the filenames are lowercase.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select File Definitions to Check in dialog box and 
their functions.

Field Function

File Definition files 
from

Displays the name of the working directory.

The list below the name displays the names of the file 
definition files in the working directory. An asterisk next 
to a name indicates that the file is currently checked 
out.

Note
You can use the browse button to select a different 
directory.

Check in File 
Definition files to

Displays the name of the master directory for file 
definition files. This is the directory to which 
Gentran:Server copies the file.

The list below the directory name displays the names 
of the file definition files in the master directory.

Add Adds the name of the selected file definition file to the 
list of file definition files in the master directory.

Remove Removes the name of the file definition file from the 
master directory check in list.

Add All Adds the names of all the file definition files in the 
working directory to the master directory.

Remove All Removes the names of all the file definition files from 
the master directory check in list.

Check in and Remove Saves your changes, starts moving the file definition 
files, and deletes the working copies from the working 
directory.

Check in and not 
Remove

Saves your changes, starts moving the file definition 
files, and retains the working copies in the working 
directory.
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Select Map and File Definition Files to Unlock Dialog 
Box 

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Unlock
◗ Select File Definition Files to Unlock

Purpose The unlock dialog box is used to remove the lock from the master file when you 
do not want to save changes to a file in your working directory. The following files 
can be unlocked:

◗ map files
◗ file definitions files

Example unlock
dialog box

The same dialog box format is used to unlock file definition files.

This illustration shows the Select Map Files to Unlock dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps created in both the Application Integration 
Mapper and the Visual Mapper with the extensions .map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Unlock dialog box and their 
functions.

Field Function

…files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Notes
You can use the browse button to select a different 
directory.

Selected <filename> 
files to unlock in

Displays the name of the master directory for the files. 
This is the directory to which Gentran:Server copies 
the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected file to the list of files in 
the master directory.

Remove Removes the name of the file from the master directory 
unlock list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory unlock list.

Unlock Unlocks the file or files you have selected
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Procedures 0

How to Check Out and View Maps and File Definitions

Introduction This topic explains how to check out a file. 

What happens
when you check

out a file

When you check out a file in Gentran:Server Workstation, Gentran:Server copies 
the file from the master directory to the working directory on the PC.

(Continued on next page)
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Checking out a
map or file

definition

Use this procedure to check out a map or a file definition file in Workstation.

Step Action

1 Select Check Out from the Gentran:Server Main File menu and 
click the type of file you want to check out.

◗ Map
◗ File Definition File

System Response
Gentran:Server displays the Select <filename> Files to 
Check out dialog box.

Notes
An asterisk next to a file name indicates that the file is 
already checked out.

The View Mode button is unavailable in Workstation.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
(Continued on next page)
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3 Use this table to determine your next step.

IF you want to check out… THEN…

a single file Select the file you want to check 
out from the list in the left pane 
and click Add.

Repeat this step for each 
additional file you want to check 
out.

4 all the available files Click Add All.

5 Click Edit Mode.

System Response
Gentran:Server displays the Check-out <filename> File 
Status dialog box.

6 Do you want to print the information displayed on the Check-out 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Save Changes to Working Files

Introduction If a an Application Integration Mapper map file is open, you can save changes on 
the PC:

◗ To the open file
◗ To the working copy of a map (but not to the original map)

Note
You can also save the map files by using a new file name.

Reference
To replace an original map with a working copy of the map that you have 
modified, see How to Check In Maps and Translation Objects  in this 
chapter.

WARNING
If you are using both the Application Integration Mapper and the 
Visual Mapper, you must be careful NOT to overwrite your .vmp map. 
If the master directory contains a map with the same name as your 
working map, then you must use a different name for your working 
map. This prevents the .map file from overwriting the .vmp file. 
For example, if you are creating a new map in the Application 
Integration Mapper using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
Gentran:Server does not recognize map extensions. When you check 
in a working map to the master directory, it overwrites any existing 
map file that has the same file name, regardless of the extension.

Saving changes
to an open file

Use this procedure to save changes to an open file.

Procedure 
Click Save on the File menu. 

System Response
Gentran:Server updates the file.

(Continued on next page)
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Saving to a new
file name

Use this procedure to save an open working map file to a new file name in the 
working directory.

CAUTION
You cannot use this procedure to save a working map file to the 
master directory.

Step Action

1 Click Save As on the File menu. 

System Response
Gentran:Server displays the Save As dialog box.

2 Type the new file name for the copy of the map.

Note
You cannot save a map file to another directory, but you can 
save it under a new file name.

Reference
See How to Check In Maps and Translation Objects in this 
chapter to replace a master map file with a modified working 
copy.

3 Click OK.

System Response
Gentran:Server saves a copy of the map under the new 
name.
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How to Unlock Master Files and Delete Working Copies

Introduction If you do not want to save changes to a file in your working directory, you can use 
the Gentran:Server Unlock function to remove the lock from the master file and 
delete the working copy of the file. This procedure explains how to use the Unlock 
function.

CAUTION
When you unlock a master file, you lose all changes you made to the 
working file. Use this procedure only if you want to delete the 
working file.

Procedure Use this procedure to unlock a master file and delete a working file.

Step Action

1 Select Unlock from the File menu and click the type of file you want 
to unlock:

◗ Map
◗ File Definition File

System Response
Gentran:Server displays the Select <filename> Files to 
Unlock dialog box.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to unlock… THEN…

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
Gentran:Server moves the 
selected file to the selected files 
to unlock list.

all the available files Click Add All.

System Response
Gentran:Server moves all the 
files to the selected files to 
unlock list.

3 Click Unlock.

System Response
Gentran:Server displays this dialog box.

(Continued on next page)

 (Contd)
Step Action
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4 Do you want to continue?

◗ If YES, click Yes.
◗ If NO, click No.

System Response
If you clicked Yes, Gentran:Server displays the Unlock 
<filename> File Status dialog box.

5 Do you want to print the information displayed on the Unlock 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
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How to Check In Maps and Translation Objects

Introduction This topic explains how to check in maps and the translation objects (TPL 
files)associated with them.

What happens
when you check

in a file

When you are satisfied that a working map and translation object produces the 
results you expect, you check in the working file. When you check in a working 
file, the system copies the file from the working directory to the master directory, 
replacing the original file. The working file becomes the new map or translation 
object. You can choose to leave a copy of the file in the working directory or 
remove it.

Maps The procedure for checking in maps differs from that for checking in other files 
because you can check in multiple maps at the same time.

You can check in a compiled working map or an uncompiled working map.
◗ If you compile a working map before you check it in, the Check In function 

moves the compiled map to the master directory.
◗ If you move an uncompiled working map, you must compile it in the master 

directory; otherwise, the translator will not recognize the changes.

(Continued on next page)
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Checking in
maps and

translation
objects

Use this procedure to check in a map and translation object.

Step Action

1 Select Check In from the Gentran:Server Main File menu and click 
Map.

System Response
Gentran:Server displays the Select Map Files to Check in 
dialog box.

WARNING
If you are using both the Application Integration Mapper 
and the Visual Mapper, you must be careful NOT to 
overwrite your .vmp map. If the master directory 
contains a map with the same name as your working 
map, then you must use a different name for your 
working map. This prevents the .map file from 
overwriting the .vmp file. 
For example, if you are creating a new map in the 
Application Integration Mapper using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
Gentran:Server does not recognize map extensions. 
When you check in a working map to the master 
directory, it overwrites any existing map file that has the 
same file name, regardless of the extension.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single map Select the map you want to 
check in from the list in the left 
pane and click Add.

Repeat this step for each 
additional map you want to 
check in.

 all the available maps Click Add All.

3 Click Next.

System Response
Gentran:Server searches for the associated translation 
object files in the default Table Location directory and 
displays the results in the Select TBL/TPL Files to Check In 
dialog box.

4 Do you want Gentran:Server to search for the translation object in a 
different directory?

◗ If YES, click the browse button next to specify the directory; 
continue with next step.

◗ If NO, continue with Step 5.
(Continued on next page)
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5 Do you want to check in the translation object associated with the 
map you are checking in?

◗ If YES, make sure that the check box next to the translation 
object is selected and then click Finish.

◗ If NO, clear the check box and then click Finish.

System Response
Gentran:Server displays this dialog box.

6 Do you want to remove the copies of the working files from the 
working directory after the files are checked in?

◗ If YES, click the Yes button.
◗ If NO, click the No button.

System Response
The system displays the Check-in Map and TBL/TPL File 
Status dialog box.

7 Do you want to print the information displayed on the Check-in 
<filename> Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
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How to Check In File Definitions 

Introduction When you are satisfied with a file definition file, you check in the working file. 
When you check in a working file, the system copies the file from the working 
directory to the master directory, replacing the original file. The working file 
becomes the new file definition. You can choose to leave a copy of the file in the 
working directory or remove it.

Checking in a file
definition

Use this procedure to check in a file definition file.

Step Action

1 Select Check In from the Gentran:Server Main File menu and click 
File Definition File.

System Response
Gentran:Server displays the Select File Definition File to 
Check in dialog box.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single file definition file Select the file definition  file you 
want to check in from the list in 
the left pane and click Add.

Repeat this step for each 
additional file you want to check 
in.

all the available file definition  
files

Click Add All.

3 Use this table to determine your next step.

IF you want to… THEN click…

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
Gentran:Server displays the Check-in File Definition File 
Status dialog box.

(Continued on next page)
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4 Do you want to print the information displayed on the Check-in 
<filename> Status dialog box?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
Getting Started Guide - March 2011



-16 - 1
CHAPTER

6

Working with Visual Mapper

Content Overview
◗ Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
◗ Working in Workstation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Dialog Boxes
◗ Select Map Files to Check Out Dialog Box  . . . . . . . . . . . . . . . . . . . 4
◗ Select IG/Application Description Files to Check out Dialog Box . . . 6
◗ Select Generic Synonym/Thesaurus File to Check out Dialog Box . 8
◗ Select Map Files to Check in Dialog Box . . . . . . . . . . . . . . . . . . . . 10
◗ Select TBL/TPL Files to Check In Dialog Box  . . . . . . . . . . . . . . . . 12
◗ Select IG/Application Description Files to Check in Dialog Box . . . 14
◗ Select Synonym and Thesaurus File to Check in Dialog Boxes  . . 16
◗ Select Map Files to Unlock Dialog Box  . . . . . . . . . . . . . . . . . . . . . 18
◗ Select IG/Application Description Files to Unlock Dialog Box  . . . . 20
◗ Synonym and Thesaurus File to Unlock Dialog Boxes  . . . . . . . . . 22

Procedures
◗ How to Check Out Maps and IG/Application Descriptions . . . . . . . 23
◗ How to Check out a Generic Synonym/Thesaurus List  . . . . . . . . . 26
◗ How to Save Changes to Working Files . . . . . . . . . . . . . . . . . . . . . 28
◗ How to Unlock Master Files and Delete Working Copies . . . . . . . . 30
◗ How to Check In Compiled Maps . . . . . . . . . . . . . . . . . . . . . . . . . . 34
◗ How to Check In IG/Application Description Files  . . . . . . . . . . . . . 38
◗ How to Check In Synonym and Thesaurus List Files . . . . . . . . . . . 41
Getting Started Guide - March 2011



Introduction Working with Visual Mapper6 - 2
Overview 0

Introduction

In this chapter This chapter contains information about working in Workstation and accessing 
and returning files.

Key terms This table describes the key terms used in this chapter.

Term Description

check in The act of returning a copy of a file from your 
working directory to the master directory, 
making it available to other users.

check out The act of copying a file from the master 
directory to your working directory, making the 
file unavailable to other users.

lock The act of making a file unavailable to other 
users. A file is locked once it is checked out.

unlock The act of making a file available to other 
users. A file is unlocked once it is checked in.
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Working in Workstation

Introduction Gentran:Server Workstation uses numerous data files such as maps, compiled 
maps (.TBL files), implementation guides (.ig files), application descriptions (.app 
files), and Trading Partnership records.

This section explains how to work with files in Gentran:Server Workstation.

Master directory Gentran:Server Workstation stores the master files (maps, compiled maps, 
implementation guides, application descriptions, etc.) on the PC in the master 
directory specified for the file type. You specify the master directories in the Set 
Up Directories dialog box, which is available from the main Gentran:Server 
window under the Settings menu.

File checkout When you want to edit a master file, you must check it out. When you check out a 
map file to edit it, Gentran:Server Workstation moves a copy of the file to the 
working directory and retains the original file in the master directory.

Working
directory

Gentran:Server Workstation stores your working files (copies of checked out 
maps, implementation guides, and application descriptions) in the working 
directory on the PC. This enables you to modify a checked-out map without 
affecting the original file. You specify the working directories in the Set Up 
Directories dialog box, which is available from the Gentran:Server Settings menu.

Map check in When you check in a map file, Gentran:Server Workstation transfers a copy of 
the file from your working directory to the master directory. If the map file is one 
that you checked out, Workstation replaces the map in the master directory with 
the working copy. The working copy becomes the new master file for the map. 
Gentran:Server lets you to choose to keep or remove the copy of the file in your 
working directory.
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Dialog Boxes 0

Select Map Files to Check Out Dialog Box

Introduction The Select Map Files to Check out dialog box is used to move a copy of a map 
from the master directory to a working directory on the PC. It also moves 
associated TBL/TPL files

Illustration This illustration shows the Select Map Files to Check out dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper capabilities, 
then the Select Map Files to Check out dialog box lists the maps created in both 
the Application Integration Mapper and the Visual Mapper with the extensions 
.map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check out dialog box and their 
functions.

Field Function

Map files from Displays the name of the master directory.

The list below the name displays the names of the 
maps in the master directory. An asterisk next to a 
name indicates that the map is currently checked out.

Check out Map files to Displays the name of the default working directory on 
your PC. This is the directory to which Gentran:Server 
copies the map file.

The list below the directory name displays the names 
of the working maps in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected map to the list of maps 
in the working directory.

Remove Removes the name of the map from the working 
directory check out list.

Add All Adds the names of all the maps in the master directory 
to the working directory.

Remove All Removes the names of all the maps from the working 
directory check out list.

Edit Mode Checks out the maps so that you can edit them. 
Copies the maps that you added to the Check out 
Map files to list and moves the copies into the working 
directory. 

View Mode View Mode is unavailable in Workstation.
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Select IG/Application Description Files to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Implementation Guide Files to Check out
◗ Select Application Description Files to Check out

Purpose The check out dialog box is used to move a copy of a file from the master 
directory to a working directory on the PC. The following files can be checked out:

◗ application descriptions files
◗ implementation guides files

Example check
out dialog box

The same dialog box format is used to check out application description files.

This illustration shows the Select Implementation Guide Files to Check out dialog 
box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Implementation Guide Files to Check Out 
and Select Application Description Files dialog box and their functions.

Field Function

 …files from Displays the name of the master directory.

The list below the name displays the names of the files 
in the master directory. An asterisk next to a name 
indicates that the file is currently checked out.

Check out <filename> 
files to

Displays the name of the default working directory on 
your PC. This is the directory to which Gentran:Server 
copies the file.

The list below the directory name displays the names 
of the working files in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected file to the list of files in 
the working directory.

Remove Removes the name of the file from the working 
directory check out list.

Add All Adds the names of all the files in the master directory 
to the working directory.

Remove All Removes the names of all the files from the working 
directory check out list.

Edit Mode Checks out the files so that you can edit them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory. 

View Mode View Mode is unavailable in Workstation.
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Select Generic Synonym/Thesaurus File to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Generic Synonym File to Check out
◗ Select Thesaurus File to Check out

Purpose The check out dialog boxes are used to move a copy of a generic synonym list or 
thesaurus list from the master directory to a working directory on the PC. 

Example check
out dialog box

The same dialog box format is used to check out a thesaurus list.

This illustration shows the Select Generic Synonym File to Check out dialog box.

Fields and
functions

This table lists the fields of the Select Generic Synonym File to Check out and the 
Select Thesaurus File to Check out dialog box and their functions.

Field Function

… file from directory Displays the name of the master directory.

To directory Displays the name of the default working directory on 
your PC. This is the directory to which Gentran:Server 
copies the file.

Note
You can use the browse button to select a different 
directory.

(Continued on next page)
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Edit Mode Checks out the file so that you can edit it. Copies the 
file that you selected and moves the copy into the 
working directory. 

View Mode View Mode is unavailable in Workstation.

 (Contd)
Field Function
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Select Map Files to Check in Dialog Box

Introduction This topic describes the Select Map Files to Check in dialog box.

Purpose The Select Map Files to Check in dialog box is used to move the saved working 
file from your working directory to the master directory. The system replaces the 
master file with the map you check in. The following files can be checked in:

◗ map files 
◗ associated TBL files

Example check
in dialog box

This illustration shows the Select Map Files to Check in dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper 
capabilities, then the dialog box will list maps created in both the Application 
Integration Mapper and the Visual Mapper with the extensions .map and 
.vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check in dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps in the working directory.

Note
You can use the browse button to select a 
different directory.

Check in Map files to Displays the name of the master directory for maps on 
your PC. This is the directory to which Gentran:Server 
copies the map file.

The list below the directory name displays the names 
of the maps in the master directory.

Add Adds the name of the selected map to the list of maps 
in the master directory.

Remove Removes the name of the map from the master 
directory check in list.

Add All Adds the names of all the maps in the working 
directory to the master directory.

Remove All Removes the names of all the maps from the master 
directory check in list.
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Select TBL/TPL Files to Check In Dialog Box

Introduction The Select TBL/TPL Files to Check In dialog box is used to select the  compiled 
maps you want to check in.

Illustration This illustration shows the Select TBL/TPL Files to Check In dialog box.

Note
If your Gentran:Server software is configured with Visual Mapper 
capabilities, then the dialog box will list maps and associated files created in 
both the Application Integration Mapper and the Visual Mapper with the 
extensions .map (TPL) and .vmp (TBL) respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select TBL/TPL to Check In dialog box and their 
functions.

Field Function

List of Map files to 
check in from 
directory

Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps you are checking in.

List of associated 
TBL/TPL files to 
check in with

Displays the names of the translation objects 
associated with the maps you are checking in. 

Finish Saves your changes and checks in the maps and 
translation objects you selected.
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Select IG/Application Description Files to Check in 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Implementation Guide Files to Check in
◗ Select Application Description Files to Check in

Purpose The check in dialog box is used to move the saved working copy of a file from 
your working directory to the master directory. The system replaces the master file 
with the file you check in. The following files can be checked in:

◗ implementation guides files
◗ application descriptions files

Example check
in dialog box

The same dialog box format is used to check in application description files.

This illustration shows the Select Implementation Guide Files to Check in dialog 
box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Implementation Guide Files to Check in and 
Select Application Description Files to Check in dialog box and their functions.

Note
When you check in a file, the system converts the filename to lowercase letters. 
UNIX client/server versions require that the filenames are lowercase.

Field Function

… files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Note
You can use the browse button to select a different 
directory.

Check in <filename> 
files to

Displays the name of the master directory for files. This 
is the directory to which Gentran:Server copies the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected file to the list of file 
definition files in the master directory.

Remove Removes the name of the file from the master directory 
check in list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory check in list. 

Check in and Remove Saves your changes, starts moving the files, and 
deletes the working copies from the working directory.

Check in and not 
Remove

Saves your changes, starts moving the files, and 
retains the working copies in the working directory.
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Select Synonym and Thesaurus File to Check in Dialog 
Boxes

Introduction This topic describes the following dialog boxes:

◗ Select Generic Synonym File to Check in
◗ Select Thesaurus File to Check in

Purpose The check in dialog box is used to move the saved working copy of a file from 
your working directory to the master directory. The system replaces the master file 
with the file you check in. The following files can be checked in:

◗ generic synonym list
◗ thesaurus list

Example check
in dialog box

The same dialog box format is used to check in thesaurus lists.

This illustration shows the Select Generic Synonym File to Check in dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Generic Synonym File to Check in and 
Select Thesaurus File to Check in dialog box and their functions.

Note
When you check in a file, the system converts the filename to lowercase letters. 
UNIX client/server versions require that the filenames are lowercase.

Field Function

Check in <filename> 
file from directory

Displays the name of the working directory.

The list below the name displays the name of the file in 
the working directory. 

Note
You can use the browse button to select a different 
directory.

To directory Displays the name of the master directory for the file. 
This is the directory to which Gentran:Server copies 
the file.

The list below the directory name displays the name of 
the file in the master directory.

Check in and Remove Saves your changes, starts moving the file, and 
deletes the working copy from the working directory.

Check in and not 
Remove

Saves your changes, starts moving the file, and retains 
the working copy in the working directory.
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Select Map Files to Unlock Dialog Box 

Introduction The Select Map Files to Unlock dialog box is used to remove the lock from the 
master file when you do not want to save changes to a map file in your working 
directory. 

Purpose The Select Map Files to Unlock dialog box is used to remove the lock from the 
master file when you do not want to save changes to a map file in your working 
directory. 

Illustration This illustration shows the Select Map Files to Unlock dialog box.

(Continued on next page)
Getting Started Guide - March 2011



Working with Visual Mapper Select Map Files to Unlock Dialog Box 6 - 19
Fields and
functions

This table lists the fields of the Select Map Files to Unlock dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory.

The list below the name displays the names of the map 
files in the working directory. An asterisk next to a 
name indicates that the file is currently checked out.

Note
You can use the browse button to select a different 
directory.

Selected Map files to 
unlock in

Displays the name of the master directory for map files. 
This is the directory to which Gentran:Server copies 
the file.

The list below the directory name displays the names 
of the map files in the master directory.

Add Adds the name of the selected map files to the list of 
map files in the master directory.

Remove Removes the name of the map file from the master 
directory unlock list.

Add All Adds the names of all the map files in the working 
directory to the master directory.

Remove All Removes the names of all the map files from the 
master directory unlock list.

Unlock Unlocks the file or files you have selected

Cancel Cancels your changes and closes the dialog box.
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Select IG/Application Description Files to Unlock 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Implementation Guide Files to Unlock
◗ Select Application Description Files to Unlock

Purpose The Select <filename> Files to Unlock dialog box is used to remove the lock from 
the master file when you do not want to save changes to a file in your working 
directory. The following files can be unlocked:

◗ implementation guide files
◗ application description files

Example unlock
dialog box

The same dialog box format is used to unlock application description files.

This illustration shows the Select Implementation Guide Files to Unlock dialog 
box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Implementation Guide Files to Unlock Select 
Application Description Files to Unlock dialog box and their functions.

Field Function

…files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Notes
You can use the browse button to select a different 
directory.

Selected <filename> 
files to unlock in

Displays the name of the master directory for the files. 
This is the directory to which Gentran:Server copies 
the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected files to the list of map 
files in the master directory.

Remove Removes the name of the file from the master directory 
unlock list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory unlock list. 

Unlock Unlocks the file or files you have selected
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Synonym and Thesaurus File to Unlock Dialog Boxes

Introduction This topic describes the following dialog boxes:

◗ Select Generic Synonym Files to Unlock
◗ Select Thesaurus Files to Unlock

Purpose The unlock dialog box is used to remove the lock from the master file when you do 
not want to save changes to a file in your working directory. The following files can 
be unlocked:

◗ generic synonym list
◗ thesaurus list

Example unlock
dialog box

The same dialog box format is used to unlock thesaurus lists.

This illustration shows the Select Generic Synonym Files to Unlock dialog box.

Fields and
functions

This table lists the fields of the Select Generic Synonym Files to Unlock and 
Select Thesaurus Files to Unlock dialog box and their functions.

Field Function

Unlock <filename> file 
from directory

Displays the name of the working directory.

Note
You can use the browse button to select a different 
directory.

Unlock Unlocks the file or files you have selected
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Procedures 0

How to Check Out Maps and IG/Application 
Descriptions

Introduction This topic explains how to check out a file. 

What happens
when you check

out a file

When you check out a file in Gentran:Server Workstation, Gentran:Server copies 
the file from the master directory to the working directory on the PC.

(Continued on next page)
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Checking out a
map, an IG, or

application
description

Use this procedure to check out a map, an implementation guide, an application 
description file in Workstation.

Step Action

1 Select Check Out from the Gentran:Server Main File menu and 
click the type of file you want to check out.

◗ Map
◗ Implementation Guide
◗ Application Description

System Response
Gentran:Server displays the Select <filename> Files to 
Check out dialog box.

Notes
An asterisk next to a file name indicates that the file is 
already checked out.

The View Mode button is unavailable in Workstation.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
(Continued on next page)
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3 Use this table to determine your next step.

IF you want to check out… THEN…

a single file Select the file you want to check 
out from the list in the left pane 
and click Add.

Repeat this step for each 
additional file you want to check 
out.

4 all the available files Click Add All.

5 Click Edit Mode.

System Response
Gentran:Server displays the Check-out <filename> File 
Status dialog box.

6 Do you want to print the information displayed on the Check-out 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check out a Generic Synonym/Thesaurus List 

Introduction This topic explains how to check out generic synonym list and a thesaurus list in 
Workstation.

Procedure Use this procedure to check out a generic synonym list or thesaurus list file in 
Workstation.

Step Action

1 Select Check Out from the Gentran:Server Main File menu and 
click the type of file you want to check out.

◗ Generic Synonym List
◗ Thesaurus List

System Response
Gentran:Server displays the Select <filename> Files to 
Check out dialog box.

Notes
An asterisk next to a file name indicates that the file is 
already checked out.

The View Mode button is unavailable in Workstation.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
(Continued on next page)
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3 Click Edit Mode.

System Response
Gentran:Server displays the Check-out <filename> File 
Status dialog box.

4 Do you want to print the information displayed on the Check-out 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Save Changes to Working Files

Introduction If a Visual Mapper map file is open, you can save changes on the PC:

◗ To the open file
◗ To the working copy of a map (but not to the original map)

Note
You can also save the map files by using a new file name.

Reference
To replace an original map with a working copy of the map that you have 
modified, see  How to Check In Compiled Maps in this chapter.

WARNING
If you are using both the Application Integration Mapper and the 
Visual Mapper, you must be careful NOT to overwrite your .vmp map. 
If the master directory contains a map with the same name as your 
working map, then you must use a different name for your working 
map. This prevents the .map file from overwriting the .vmp file. 
For example, if you are creating a new map in the Application 
Integration Mapper using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
Gentran:Server does not recognize map extensions. When you check 
in a working map to the master directory, it overwrites any existing 
map file that has the same file name, regardless of the extension.

Saving changes
to an open file

Use this procedure to save changes to an open file.

Procedure 
Click Save on the File menu. 

System Response
Gentran:Server updates the file.

(Continued on next page)
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Saving to a new
file name

Use this procedure to save an open working map file to a new file name in the 
working directory.

CAUTION
You cannot use this procedure to save a working map file to the 
master directory.

Step Action

1 Click Save As on the File menu. 

System Response
Gentran:Server displays the Save As dialog box.

2 Type the new file name for the copy of the map.

Note
You cannot save a map file to another directory, but you can 
save it under a new file name.

Reference
See  How to Check In Compiled Maps in this chapter to 
replace a master map file with a modified working copy.

3 Click OK.

System Response
Gentran:Server saves a copy of the map under the new 
name.
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How to Unlock Master Files and Delete Working Copies

Introduction If you do not want to save changes to a file in your working directory, you can use 
the Gentran:Server Unlock function to remove the lock from the master file and 
delete the working copy of the file. This procedure explains how to use the Unlock 
function.

CAUTION
When you unlock a master file, you lose all changes you made to the 
working file. Use this procedure only if you want to delete the 
working file.
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Procedure Use this procedure to unlock a master file and delete a working file.

Step Action

1 Select Unlock from the File menu and click the type of file you want 
to unlock:

◗ Map
◗ Implementation Guide
◗ Application Description
◗ Generic Synonym List
◗ Thesaurus List

System Response
Gentran:Server displays the Select <filename> Files to 
Unlock dialog box.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to unlock… THEN…

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
Gentran:Server moves the 
selected file to the selected files 
to unlock list.

all the available files Click Add All.

System Response
Gentran:Server moves all the 
files to the selected files to 
unlock list.

a generic synonym or 
thesaurus list

Go to Step 3.

3 Click Unlock.

System Response
Gentran:Server displays this dialog box.

(Continued on next page)
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4 Do you want to continue?

◗ If YES, click Yes.
◗ If NO, click No.

System Response
If you clicked Yes, Gentran:Server displays the Unlock 
<filename> File Status dialog box.

5 Do you want to print the information displayed on the Unlock 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check In Compiled Maps

Introduction This topic explains how to check in maps and the compiled maps (TBL files) 
associated with them.

What happens
when you check

in a file

When you are satisfied that a working map and compiled map produces the 
results you expect, you check in the working file. When you check in a working 
file, the system copies the file from the working directory to the master directory, 
replacing the original file. The working file becomes the new map or compiled 
map. You can choose to leave a copy of the file in the working directory or remove 
it.

Maps The procedure for checking in maps differs from that for checking in other files 
because you can check in multiple maps at the same time.

You can check in a compiled working map or an uncompiled working map.
◗ If you compile a working map before you check it in, the Check In function 

moves the compiled map to the master directory.
◗ If you move an uncompiled working map, you must compile it in the master 

directory; otherwise, the translator will not recognize the changes.

(Continued on next page)
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Checking in
maps and

compiled maps

Use this procedure to check in a map and compiled map.

Step Action

1 Select Check In from the Gentran:Server Main File menu and click 
Map.

System Response
Gentran:Server displays the Select Map Files to Check in 
dialog box.

WARNING
If you are using both the Application Integration Mapper 
and the Visual Mapper, you must be careful NOT to 
overwrite your .vmp map. If the master directory 
contains a map with the same name as your working 
map, then you must use a different name for your 
working map. This prevents the .map file from 
overwriting the .vmp file. 
For example, if you are creating a new map in the 
Application Integration Mapper using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
Gentran:Server does not recognize map extensions. 
When you check in a working map to the master 
directory, it overwrites any existing map file that has the 
same file name, regardless of the extension.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single map Select the map you want to 
check in from the list in the left 
pane and click Add.

Repeat this step for each 
additional map you want to 
check in.

 all the available maps Click Add All.

3 Click Next.

System Response
Gentran:Server searches for the associated translation 
object files in the default Table Location directory and 
displays the results in the Select TBL/TPL Files to Check In 
dialog box.

4 Do you want Gentran:Server to search for the translation object in a 
different directory?

◗ If YES, click the browse button next to specify the directory; 
continue with next step.

◗ If NO, continue with Step 5.
(Continued on next page)
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5 Do you want to check in the compiled map associated with the map 
you are checking in?

◗ If YES, make sure that the check box next to the translation 
object is selected and then click Finish.

◗ If NO, clear the check box and then click Finish.

System Response
Gentran:Server displays this dialog box.

6 Do you want to remove the copies of the working files from the 
working directory after the files are checked in?

◗ If YES, click the Yes button.
◗ If NO, click the No button.

System Response
The system displays the Check-in Map and TBL/TPL File 
Status dialog box.

7 Do you want to print the information displayed on the Check-in 
<filename> Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check In IG/Application Description Files

Introduction When you are satisfied with an implementation guide or application description 
file, you check in the working file. When you check in a working file, the system 
copies the file from the working directory to the master directory, replacing the 
original file. The working file becomes the new implementation guide or 
application description. You can choose to leave a copy of the file in the working 
directory or remove it.

Checking in an
IG or application

description

Use this procedure to check in an implementation guide or application description 
file.

Step Action

1 Select Check In from the Gentran:Server Main File menu and click 
either Implementation Guide or Application Description.

System Response
Gentran:Server displays the Select <filename> File to Check 
in dialog box

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single implementation guide or 
application description file 

Select the implementation guide 
or application description file 
you want to check in from the 
list in the left pane and click 
Add.

Repeat this step for each 
additional file you want to check 
in.

all the available implementation 
guide or application description 
files

Click Add All.

(Continued on next page)
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3 Use this table to determine your next step.

IF you want to… THEN click…

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
Gentran:Server displays the Check-in  <filename> File Status 
dialog box.

4 Do you want to print the information displayed on the Check-in 
<filename> Status dialog box?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check In Synonym and Thesaurus List Files

Introduction When you are satisfied with a synonym or a thesaurus list file, you check in the 
working file. When you check in a working file, the system copies the file from the 
working directory to the master directory, replacing the original file. The working 
file becomes the new file definition. You can choose to leave a copy of the file in 
the working directory or remove it.

checking in a
generic

synonym list or
thesaurus list

Use this procedure to check in a generic synonym or a thesaurus list file.

Step Action

1 Select Check In from the Gentran:Server Main File menu and click 
the file you want to check in:

◗ Generic Synonym List
◗ Thesaurus List

System Response
Gentran:Server displays the Select <filename> File to Check in 
dialog box.

2 Select the generic synonym file or thesaurus file you want to check 
in.

(Continued on next page)
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Note
When you check in a file, the system converts the filename to lowercase letters. 
UNIX client/server versions require that the filenames are lowercase.

3 Use this table to determine your next step.

IF you want to… THEN click…

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

4 System Response

Gentran:Server displays the Check-in <filename> File Status dialog 
box.

5 Do you want to print the status report?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Glossary
Acrobat Reader An Adobe program designed to read and display Portable Document Format 
(PDF) documents.

application The business software generating the business information that you are sending 
or receiving electronically.

check in The act of returning a copy of a file from your working directory to the master 
directory, making it available to other users.

check out The act of copying a file from the master directory to your working directory, 
making the file unavailable to other users.

default A value that is automatically assigned.

DNS Domain Name Services.

EDI Electronic Data Interchange.

Application-to-application transfer of key business transaction information in a 
standard or XML format via a computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of transaction data.

GENCOD The GENCOD standard was developed by the French National Numbering 
Organization GENCOD-EAN France. The GENCOD standard is used mainly in 
France within the retail market by some major retailers and manufacturers.
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HIPAA Health Insurance Portability and Accounting Act.

lock The act of making a file unavailable to other users. A file is locked once it is 
checked out.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI document and the data fields 
in your application,

◗ The elements in an XML document and the data fields in your application, EDI 
standard document, or in another XML document,

◗ The segments and elements of two different standards, or
◗ The records and fields of two different applications.

master directory The directory on a PC or on a server that stores your master files.

master file The version of a file that Gentran:Server uses to process data. 

MDAC Microsoft Data Access Components.

NCPDP National Council of Prescription Drug Programs.

ODBC Open Database Connectivity.

PCM Process Control Manager.

standard format A format intelligible to computerized data management systems.
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temporary file A file on the client that Gentran:Server uses during editing and compiling.

trading partner The company, division, or group with which you are exchanging business data 
electronically.

Trading
Partnership

An arrangement to exchange information in a specific document type with a 
specific trading partner and using a particular standard version.

unlock The act of making a file available to other users. A file is unlocked once it is 
checked in.

user directory The directory on the server that temporarily holds the files being transferred from 
a client’s working directory to the master directory on the server.

VAN Value Added Network.

VDA Verband der Deutschen Automobilindustrie. A German group responsible for a 
range of different standards in the automobile industry.

working file
directory

The directory created on the client to hold the files that a user is editing.

XML Extensible Markup Language. Describes a class of data objects called XML 
documents, and partially describes the behavior or computer programs which 
process them.
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Index
A
application description

checking in  6-38
checking out  6-23
length of file name  3-15
unlocking  6-31

Asynchronous communications
setting up  2-26

B
bisynchronous communications

setting up  2-12

C
check in

in Workstation  5-3,  5-22,  6-3,  6-34
checking in

application descriptions  6-38
compiled maps  6-34
file definitions  5-26
generic synonym list  6-41
implementation guides  6-38
maps  5-22,  6-34
thesaurus list  6-41
translation objects  5-22

checking out  5-14
application descriptions  6-23
file definitions  5-14
file in Workstation  5-14,  6-23
generic synonym list  6-26
implementation guides  6-23
maps  5-14,  6-23
TBL/TPL files  5-4,  6-4
thesaurus list  6-26

Cleo 3780Plus
Communications Toolkit  2-3
troubleshooting  2-26

Cleo A+
Communications Toolkit  2-3

Communications Toolkit  2-1
Cleo 3780Plus  2-3
Cleo 3780Plus troubleshooting  2-26
Cleo A+  2-3
Comm subdirectory structure  2-5
communicating with VANs  2-2

connecting to VANs and directly to trading 
partners  2-27
overview  2-2
parts and functions  2-3
setting up asynchronous communications  2-26

compiled map
checking in  6-34

configuration file
van  2-10

Connecting to Miscellaneous Vans and Directly to 
Trading Partners  2-27

D
data manager

length of file name  3-15
data manager pattern

length of file name  3-15
deleting

working copies  5-19,  6-30
directory name length  3-14

E
editing a file  4-18

F
File Browser  4-15,  4-17,  4-18

caution for using  3-12
exiting  4-19
opening a file  4-17
saving a file  4-19
starting  4-17
when to use  4-15

file check out
in Workstation  5-3,  6-3

file definition
checking in  5-26
checking out  5-14
length of file name  3-15
unlocking  5-19

File name
character restrictions  3-16
conventions  3-14
invalid characters  3-16
length  3-15
validation  3-14
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G
generic synonym list

checking in  6-41
checking out  6-26
unlocking  6-31

I
implementation guide

checking in  6-38
checking out  6-23
length of file name  3-15
unlocking  6-31

input file
length of file name  3-15

ISAM files
editing caution  3-12

M
Main Window buttons  4-10
map

checking in  5-3,  6-3
checking out  5-14,  6-23
length of file name  3-15
unlocking  5-19,  6-31

mapping table
length of file name  3-15

master directory
in Workstation  5-3,  6-3

master file
unlocking  5-19,  6-30

Microcom Network Protocol  2-10
modifying

VAN configuration files  2-10

O
On-line Help

using  4-13
output file

length of file name  3-15

Q
queue

length of file name  3-15

S
saving a file  4-19

application descriptions  6-28
file definition  5-17
generic synonym list  6-28
implementation guides  6-28
map  6-28

maps  5-17
thesaurus list  6-28

script
length of file name  3-15

Select Application Description Files to Check in 
dialog box  6-14
Select Application Description Files to Unlock di-
alog box  6-20
Select Application Description to Check out dia-
log box  6-6
Select File Definition Files to Check in dialog box 
 5-10
Select File Definition Files to Unlock dialog box  5-
12
Select Generic Synonym File to Check out dialog 
box  6-8
Select Generic Synonym Files to Check in dialog 
box  6-16
Select Generic Synonym Files to Unlock dialog 
box  6-22
Select Implementation Guide Files to Check in di-
alog box  6-14
Select Implementation Guide Files to Check out 
dialog box  6-6
Select Implementation Guide Files to Unlock dia-
log box  6-20
Select Map Files to Check in dialog box  5-6,  6-10
Select Map Files to Check out dialog box  5-4,  6-4
Select Map Files to Unlock dialog box  5-12,  6-18
Select TBL/TPL Files to Check In dialog box  5-8, 
 6-12
Select Thesaurus Files to Check in dialog box  6-
16
Select Thesaurus Files to Check out dialog box  
6-8
Select Thesaurus Files to Unlock dialog box  6-22
setting up

bisynchronous communications  2-12
Status Bar

using  4-12

T
TBL/TPL

checking out  5-4
thesaurus list

checking in  6-41
checking out  6-26
unlocking  6-31

Toolbar  4-10
using  4-11

transaction register
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length of file name  3-15
translation object

checking in  5-22

U
unlocking

a generic synonym list  6-31
a thesaurus list  6-31
application descriptions  6-31
file definitions  5-19
implementation guides  6-31
maps  5-19,  6-31
master files  5-19,  6-30

using
on-line help  4-13
Status Bar  4-12
Toolbar  4-11

V
Value-Added Network (VAN)

Communications Toolkit  2-2

W
Window  4-15
working copy

deleting  5-19,  6-30
working directory

in Workstation  5-3,  6-3
working file

saving  5-17,  6-28
Workstation

check in  5-3,  6-3
file check out  5-3,  6-3
working directory  5-3,  6-3
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